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1 Safety
1.1 Introduction
1.1.1 Content of this Document

This document contains information required to use the product in the relevant phases of the 
product life cycle. This may include information on the following:

 Product identification
 Delivery, transport, and storage
 Mounting and installation
 Commissioning and operation
 Maintenance and repair
 Troubleshooting
 Dismounting
 Disposal

The documentation comprises the following parts:

 This document
 Datasheet

In addition, the documentation may comprise the following parts, if applicable:

 EU-type examination certificate
 EU declaration of conformity
 Attestation of conformity
 Certificates
 Control drawings
 Instruction manual
 Other documents

1.1.2 Manufacturer

1.1.3 Target Group, Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, and 
dismounting lies with the plant operator.

Only appropriately trained and qualified personnel may carry out mounting, installation, 
commissioning, operation, maintenance, and dismounting of the product. The personnel must 
have read and understood the instruction manual and the further documentation.

Prior to using the product make yourself familiar with it. Read the document carefully.

Note!
For full information on the product, refer to the further documentation on the Internet at 
www.pepperl-fuchs.com.

Pepperl+Fuchs GmbH
Lilienthalstraße 200, 68307 Mannheim, Germany
Internet: www.pepperl-fuchs.com
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1.1.4 Symbols Used
This document contains symbols for the identification of warning messages and of informative 
messages.

Warning Messages
You will find warning messages, whenever dangers may arise from your actions. It is 
mandatory that you observe these warning messages for your personal safety and in order to 
avoid property damage.

Depending on the risk level, the warning messages are displayed in descending order as 
follows:

Informative Symbols

Action
This symbol indicates a paragraph with instructions. You are prompted to perform an action or 
a sequence of actions.

Danger!
This symbol indicates an imminent danger.

Non-observance will result in personal injury or death.

Warning!
This symbol indicates a possible fault or danger.

Non-observance may cause personal injury or serious property damage.

Caution!
This symbol indicates a possible fault.

Non-observance could interrupt the device and any connected systems and plants, or result in 
their complete failure.

Note!
This symbol brings important information to your attention.
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2 Product Specifications
2.1 Functional Overview

The WirelessHART gateway is the interface between the WirelessHART network and the 
process control system. It supports WirelessHART networks with up to 250 network 
participants and provides an RS-485 interface as well as an Ethernet interface. Both interfaces 
transmit the HART or EtherNet/IP protocol. OPC connectivity can be realized via the HART 
OPC server. It can be configured via the device type manager (DTM) or device description 
(DD) in connection with a configuration software. Furthermore, it provides a web interface for 
direct access via a web browser.

Key Features
 Graphical network analysis
 Simple and automatic configuration options
 Ethernet and RS-485 interface
 HART protocol via both interfaces
 EtherNet/IP protocol via Ethernet interface
 Input WirelessHART wireless interface
 24 V DC supply
 Redundant power supply connections

2.1.1 Network Management
The WirelessHART gateway contains a network manager. The network manager takes care of 
the wireless communication between the WirelessHART field devices. The network manager 
takes care of the creation and maintenance of the wireless mesh network to ensure proper 
communication between the WirelessHART field devices. 

Figure 2.1 Network management
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1. Step 1: advertising
2. Step 2: joining
3. Step 3: scheduling
4. WirelessHART gateway
5. WirelessHART field device

First, the network manager sends advertising messages to announce the network’s existence. 
When a WirelessHART field device receives such an advertising message, it tries to join the 
network. If the WirelessHART field device can identify itself with the same network ID and join 
key as stored in the WirelessHART gateway, the field device is allowed to join the network. 
Otherwise, the field device will be rejected.
The network manager can also instruct already joined devices to advertise on its behalf.

In the next step, the network manager sends scheduling information to the field device. The 
field device is told how to participate in the network and receives various information from the 
WirelessHART gateway:

 Number and identity of neighboring WirelessHART field devices,
 When to send messages and which channels to use,
 When to repeat messages for other WirelessHART field devices,
 The optimal communication path for messages as well as alternative communication 

paths in case of failure.
During this process, the field device may also apply to send messages in certain intervals and 
ask the network manager for the appropriate resources. The network manager then takes care 
that these resources are available. For example, the network manager informs other 
WirelessHART field devices when to repeat messages.

2.1.2 Security Management
The security manager is part of the WirelessHART gateway. To make communication safe, all 
messages are encrypted with industry-standard AES-128 block ciphers with symmetric keys. 
Therefore, messages are unreadable for external listeners. 

The security manager distributes the encryption keys and changes them in certain (random) 
intervals, as an option.

2.1.3 Virtual Remote I/O system
The WirelessHART gateway makes wireless communication accessible to host systems 
capable of HART technology through the following principles.

WirelessHART devices and wired devices connected to a WirelessHART adapter are made 
available to host systems via a virtual HART I/O system. This I/O system contains one or 
multiple I/O cards. Each I/O card has up to 2 channels. To each channel, up to 6 wired field 
devices may be connected in multi-drop mode.   see Figure 2.2 on page 11

The WirelessHART gateway assigns a virtual I/O card to each WirelessHART device and 
stores card and channel values in a list. The I/O cards are assigned to the WirelessHART 
devices in chronological order (0 ... 249). New WirelessHART devices in the network are 
assigned to the next available I/O card.

WirelessHART devices are always assigned to channel 0 of an I/O card. All wired devices 
connected to a WirelessHART adapter are always assigned to channel 1 of the same I/O card 
as the adapter (multi-drop mode).
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Figure 2.2 Network structure and corresponding I/O structure

1. Host application
2. WirelessHART gateway
3. WirelessHART field device (joined first): I/O card 0, channel 0
4. WirelessHART adapter (joined second): I/O card 1, channel 0
5. Wired devices 1...3 connected to WirelessHART adapter: I/O card 1, channel 1

If a WirelessHART device loses its connection to the WirelessHART gateway, it keeps its 
position in the list and stays assigned to the respective I/O card. If the connection to the 
WirelessHART gateway is re-established, the WirelessHART device has the same 
channel/card values that it had before.

The same principle applies to the field devices connected to the WirelessHART adapter. After 
communication to the WirelessHART gateway was lost, the field devices regain their previous 
position as soon as the connection is re-established.

Long Tag Emulation
The WirelessHART communication protocol uses the long tag to address devices. However, 
long tags are only supported by HART 6 devices and newer devices (HART 6 = version 6 of 
the HART communication protocol; current version: HART 7). Older devices, for example 
HART 5 devices, have to be addressed by the "Message" field. If a HART 5 device is 
connected to the WirelessHART network using a WirelessHART adapter, the WirelessHART 
gateway emulates the long tag with the "Message" field.

Note!
This list is stored in a non-volatile memory of the WirelessHART gateway. The card and 
channel number assignment will remain the same after a restart of the WirelessHART gateway 
or software.
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2.1.4 Gateway Cache Management
The WirelessHART gateway caches parameters and dynamic values of the wireless and wired 
subdevices and makes them available to the host. Some commands are automatically cached 
by the WirelessHART gateway (upon read). Other commands, for example dynamic values, 
are only cached if the respective field device publishes them (upon publishing). See chapter 
5.4.2 Burst Lists

The responses to the commands listed in the following table are cached in the WirelessHART 
gateway. Commands in the same row have an identical response frame and share the same 
cache memory. The write commands (17, 18, 22, 51) will never get an immediate answer, but 
their response will be cached (caching upon write-confirmation).

Information Cached by WirelessHART Gateway

Status Information Caching
The WirelessHART gateway caches the device status byte separately for each wireless or 
wired device. The device status will be cached from any type of received message, no matter if 
from a wired or wireless device, or if it is a "published" or "normal" response.

The extended device status byte is cached in a similar way, but is available only for wireless 
devices.

2.2 Scope of Delivery
The scope of delivery comprises the following components

 Device WHA-GW-*
 Antenna W-ANT-2400-2DB-ROD (Part. No. 215520)
 3 stopping plugs for unused cable glands
 Product documentation

Cache Command Description
Static configuration 
commands, cached upon 
read or upon write 
confirmation

0, 11, 21 Read unique identifier (associated with tag or 
long tag)

12, (17) Read (Write) Message
13, (18) Read (Write) Short Tag, Descriptor, Date
20, (22) Read (Write) Long Tag
50, (51) Read (Write) Dynamic Variable Assignments

Dynamic value commands, 
cached upon publishing only

1 Read Primary Variable
2 Read Current and Percentage
3 Read All Variables
9 Read Device Variables and Status
33 Read Device Variables
93 Read Trend
48 Read Additional Device Status
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2.3 Operating Elements and Indicators
Inside the enclosure of the WirelessHART gateway there are LED indicators, DIP switches and 
buttons. The operating elements and indicators can be accessed when the enclosure is open.

Figure 2.3 WHA-GW with open enclosure

1. LEDs
2. Button A
3. Button B
4. DIP switches

2.3.1 LEDs

Figure 2.4 LED indicators

1. RS-485 communication status (yellow LED)
2. Power supply (green LED)
3. WirelessHART communication status (yellow LED)
4. Fault (red LED)
5. Ethernet communication status (yellow LED)
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LED Indicators
LED indicators
RS-485 communication status (yellow LED)
LED flashes A message is received by the WirelessHART gateway via the serial interface. 

The LED does not flash if the message is not addressed to the WirelessHART 
gateway or if a communication error was detected within the message.

LED off No serial communication at present.
Power supply (green LED)
LED on Power connected. The WirelessHART gateway ready.
LED flashes Power connected, but the WirelessHART gateway is not yet ready to send 

wireless commands, for example, right after power-up or after a device reset.
LED off Power disconnected. The LED may remain off for up to 40 seconds after 

connection to power (system boot-up).
WirelessHART communication status (yellow LED)
LED flashes A WirelessHART message is received by the WirelessHART gateway via the 

wireless interface (including published commands and excluding published 
events and notifications).

LED off No wireless communication at present.
Fault (red LED)
LED on Hardware fault which makes normal operation of the WirelessHART gateway 

impossible.
LED flashes Under certain conditions the LED flashes while the WirelessHART gateway 

application tries to eliminate the fault.
LED off No hardware fault.
Ethernet communication status (yellow LED)
LED flashes A message is received by the WirelessHART gateway via the Ethernet 

interface. The LED does not flash if the message is not addressed to the 
WirelessHART gateway or if a communication error was detected within the 
message.

LED off No Ethernet communication at present.
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2.3.2 Buttons and DIP Switches

Figure 2.5 Buttons inside the enclosure of the WirelessHART gateway

1. Button A
2. Button B

Time pressed Function

Function of button A
> 3 seconds Configuration reset: This button resets all parameters to the factory default 

values, except the parameters set by button B and button A + B.
After 3 seconds, all LEDs light up to confirm the reset.

Function of button B
> 3 seconds Communication reset: This button resets all parameters related to the wired 

communication channels to the factory default values.
After 3 seconds, all LEDs light up to confirm the reset.

Function of button [A + B] (security mode disabled)
> 3 seconds Password reset: When pressed while the Security Mode is disabled (  see 

Figure 2.6 on page 16), the buttons reset the password of the web interface 
(HTTPS password) to the factory default value. The factory default password 
for the web interface (HTTPS) is "admin".
After 3 seconds, all LEDs light up to confirm the reset.

Function of button [A + B] (security mode enabled)
> 3 seconds Network manager reset: When pressed while the Security Mode is enabled 

(  see Figure 2.6 on page 16), the buttons reset the join key, network ID, 
radio power and access mode to the factory default values.
After 3 seconds, all LEDs light up to confirm the reset.
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Figure 2.6 DIP switches

1 Switches 1 - 4: Polling address
2 Switches 5 - 6: Baud rate
3 Switch 7: RS-485 termination
4 Switch 8: Security mode

Note!
When using the DIP switches 1 ... 4 for setting the polling address of the WirelessHART 
gateway, you can set addresses ranging from 0 ... 15 only. Alternatively you can set the polling 
address using the configuration software. See chapter 5.3.3
If using the configuration software, you can set addresses ranging from 0 ... 63 (HART).

DIP switches 1 ... 4
SW1 SW2 SW3 SW4 Polling address
OFF OFF OFF OFF 0
ON OFF OFF OFF 1
OFF ON OFF OFF 2
ON ON OFF OFF 3
OFF OFF ON OFF 4
ON OFF ON OFF 5
OFF ON ON OFF 6
ON ON ON OFF 7
OFF OFF OFF ON 8
ON OFF OFF ON 9
OFF ON OFF ON 10
ON ON OFF ON 11
OFF OFF ON ON 12
ON OFF ON ON 13
OFF ON ON ON 14
ON ON ON ON 15
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Note!
When using the DIP switches 5 ... 6 for setting the baud rate, this baud rate applies for the 
HART protocol. Alternatively you can set the baud rate using the configuration software. See 
chapter 5.3.3
If using the configuration software you can set individual baud rates for the HART protocol.

DIP switches 5 ... 6
SW5 SW6 Baud rate
OFF OFF 9600
ON OFF 19200
OFF ON 38400
ON ON 57600

Note!
The security mode has to be enabled (DIP switch 8) to change the join key using the DTM or 
web interface or to reset the join key and network ID using the buttons inside the enclosure of 
the WirelessHART gateway.

Caution!
Network security risk

Do not to use the security mode connection as a normal communication channel.
After the join key has been changed, disable the security mode (DIP switch 8 = OFF).

DIP switches 7 + 8

SW7
RS-485 
termination SW8 Security mode

ON Connected ON Enabled
OFF Disconnected OFF Disabled
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3 Installation
3.1 Mounting Considerations
3.1.1 Positioning the WirelessHART Gateway

Install the WirelessHART gateway first, before installing other WirelessHART devices. This 
way you can check for proper operation of new devices as they are installed. Nevertheless, 
consider the location of future WirelessHART devices that will be routed through the 
WirelessHART gateway to ensure good connectivity.

Guidelines for Planning a WirelessHART Network
 A line-of-sight between communication partners always is desirable. If a line-of-sight is 

not possible, the obstacles should not be massive and the partners should be more to the 
edge of an obstacle to allow the wave to "bend" around it (diffraction effect).

 Consider moving objects that could affect the device's antenna range.
 Install wireless devices at least 1 m above the ground.
 Make sure that the device's antenna is aligned vertically for best results.
 Make sure that a minimum of 2 other WirelessHART devices are well within the antenna 

range of the device.
 Do not position WirelessHART devices directly below or above each other. They would 

be outside each other's antenna range.
 Install WirelessHART devices at least 1 m away from each other.
 Antennas must be at least 6 cm away from any wall or any metallic material running 

parallel to it.
 Position the device as far away as possible from metal surfaces or walls containing metal. 

There should be as little metal close to the device as possible.
 Do not position other 2.4 GHz devices like cordless phone bases or WLAN routers near 

WirelessHART devices. Keep in mind other wireless networks using the same frequency 
spectrum (WLAN, Bluetooth, etc.). Wireless technologies used in an industrial 
environment must be able to coexist without disrupting each other. If multiple networks 
operate in one plant, a frequency management should be applied as part of 
administration. 

If it is not possible to mount the WirelessHART gateway outdoors, you can also connect a 
remote antenna to the WirelessHART gateway and mount the remote antenna outdoors. 

3.1.2 Antenna Characteristics
The included antenna W-ANT-2400-2DB-ROD (Part. No. 215520) is an omnidirectional dipole 
antenna. If you point the antenna upwards, the signal radiates horizontally with an angle of 
approx. 45 degrees above and below the horizontal (donut shaped). Almost no signal will be 
radiated directly above and below the antenna. Consider this when planning a WirelessHART 
network. The height differences between wireless devices in a network should not be too big.

This is valid only for an antenna, which is placed outdoors with no metal surfaces in immediate 
vicinity. The radiation pattern changes significantly when metal surfaces are close to the 
antenna.

The following diagrams show the antenna gain in two different planes.
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Figure 3.1 Antenna gain (side view, 2450 MHz, dBi)

Figure 3.2 Antenna gain (top view, 2450 MHz, dBi)
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3.1.3 Examples for Good and Poor Positioning

Figure 3.3 Wave propagation, schematic representation (alpha = approx. 45°, may vary 
considerably)

Figure 3.4 Good positioning: Devices are within each other's antenna range

1 Weaker signal above and below; almost no signal directly above and below
2 Stronger signal sideways

x

y
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Figure 3.5 Poor positioning: Devices are not within each other's antenna range

3.2 Installing the Antenna

Connecting the Standard Antenna (W-ANT-2400-2-ROD)
Firmly screw the antenna to the antenna terminal of the WirelessHART gateway.

x

y

Danger!
Explosion hazard from connection or disconnection activities

Connection and disconnection of cables or antennas may cause a spark that can ignite a 
potentially explosive atmosphere.

Connect or disconnect cables or antennas only in the absence of a potentially explosive 
atmosphere.

Note!
Avoid radio wave deflections
In order to ensure full functionality of the device antenna, the antenna must have a minimum 
distance of 20 cm from any surrounding personnel or items when the device is in operation.
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3.3 Installing a Remote Antenna
If the WirelessHART gateway is mounted indoors, or if there are many metal obstacles in the 
immediate surroundings, you can also connect a remote antenna to the WirelessHART 
gateway. Note that the use of a different antenna or the use of an antenna with a different 
antenna gain is subject to legal restrictions.

Figure 3.6 Installation diagram

1. External antenna (omnidirectional or directional antenna)
2. Coaxial adapter
3. Coaxial cable
4. /4 surge protector
5. Coaxial cable
6. Coaxial adapter
7. WirelessHART gateway

Figure 3.7 Connection diagram for standard and non-standard antennas

Installation Diagram

Connection Diagram

1

6

7

5

3

4

2

WHA-GW-*

WHA-GW-*

TNCFTNCMNFNMNF NFNMNMTNCM NFTNCF NM

NF TNCFTNCMNFNMNF NFNMNM NM

Maximum Gain

Standard
Antenna
2 dBi

Non-Standard
Antenna 6 ... 14 dBi

Adapter Surge
Protector

or
Adapter

Coaxial Cable Coaxial Cable Adapter WirelessHART
Gateway
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Installation Examples

Remote antennas and accessories must respect the following limits:

 Antenna must comply with the laws for usage of 2400 MHz equipment of the country of 
installation.

 Radio frequency  50 µJ
 Radio frequency power  2 W
 Antenna gain  20 dBi

Furthermore, the allowed antenna gain depends on the laws for usage of 2400 MHz 
equipment of the country of installation.

 Maximum gain for EU  4 dBi
Maximum gain for US & Canada  2 dBi
The maximum gain consists of the antenna gain minus the loss of all other components, 
such as, cables, adapters, etc.

Antenna
WirelessHART 
gateway radio power 1

Cable configurations for coaxial cable W-
ACC-CA-NM-NM-*
EU US & Canada

W-ANT-2400-2-ROD
Omnidirectional rod 
antenna
2 dBi

10 dBm  1 m
 1 m + 1 m
 2 m

 1 m
 1 m + 1 m
 2 m

W-ANT-2400-6dB-
ROD-NF
Omnidirectional rod 
antenna
6 dBi

10 dBm  2 m + 2 m
 5 m
 5 m + 1 m
 5 m + 2 m

The use of alternative 
antennas is not 
allowed.

W-ANT-2400-8dB-
PAN-NF
Directional panel 
antenna
8.5 dBi

10 dBm  5 m + 2 m
 5 m + 5 m
 10 m

The use of alternative 
antennas is not 
allowed.

W-ANT-2400-14dB-
PAN-NF
Directional panel 
antenna
14 dBi

10 dBm  5 m + 10 m The use of alternative 
antennas is not 
allowed.0 dBm  1 m

 1 m + 1 m
 2 m
 2 m + 1 m
 2 m + 2 m

1 The power level of the WirelessHART gateway can be configured using the Wireless 
Communication Parameters. See chapter 5.2

Danger!
Explosion hazard or loss of radio approval through unsuitable accessories

The use of unsuitable or unapproved accessories may void the Ex certification or radio 
approval of the device and present an explosion hazard or violate the national radio 
regulations.

Only use suitable, certified remote antennas and accessories that are listed in the installation 
examples or that respect the limits mentioned below. If in doubt, consult your national 
regulations expert.
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Connecting a Remote Antenna
1. Select an installation example that meets the legal requirements and restrictions of the coun-

try of installation. See table "Installation Examples" on page 23
2. Install the components according to the installation diagram.   see Figure 3.6 on page 22
3. Install the surge protector according to the instructions given by the manufacturer. If 

possible, the surge protector should be grounded directly to keep the ground connection as 
short as possible. Note that only a complete protection system according to IEC 62305-1 
can protect your equipment and personnel.

4. Protect outdoor connections with weatherproof sealing tape to minimize corrosion and to 
improve long-term durability.

Danger!
Danger to life from electric shock through transients and lightning in outdoor installations

Outdoor installations can be subject to lightning.

 Install a surge protector to protect the installation against transients or damage caused by 
lightning.

 Refrain from installation and maintenance activities during thunderstorms.

Danger!
Explosion hazard from connection or disconnection activities

Connection and disconnection of cables or antennas may cause a spark that can ignite a 
potentially explosive atmosphere.

Connect or disconnect cables or antennas only in the absence of a potentially explosive 
atmosphere.

Caution!
Property damage through wrong installation

Wrong installation may impair the function of the WirelessHART network or cause damage to 
the WirelessHART gateway.

Ensure that only trained and qualified personnel carry out mounting and installation of the 
remote antenna and the related accessories such as cables, surge protectors, and adapters.
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3.4 Mounting the Gateway

The mounting location should be well accessible for mounting and electrical installation. Make 
sure that there is enough space to open the enclosure cover and to access the terminals, 
switches, and cable glands. Choose a mounting location that meets the requirements of the 
climatic limits specified in the technical data.

Danger!
Explosion hazard from live wiring of non-intrinsically safe circuits

If you connect or disconnect energized non-intrinsically safe circuits in a potentially explosive 
atmosphere, sparks can ignite the surrounding atmosphere.

Only connect or disconnect energized non-intrinsically safe circuits in the absence of a 
potentially explosive atmosphere.

Danger!
Explosion hazard from sparking when using operating elements

Using operating elements in a potentially explosive atmosphere can cause sparks that can 
ignite the surrounding atmosphere. 

Only use operating elements (e. g., switch, slider, button, etc.) in the absence of a potentially 
explosive atmosphere. 

Danger!
Danger to life from electric shock through degree of protection violation

Failing to ensure the degree of protection for the enclosure according to EN 60529 can result in 
severe or lethal electric shock.

Ensure that the enclosure meets the required degree of protection during mounting and 
installation activities: 
- All seals must be undamaged and correctly fitted
- All screws of the housing/housing cover must be tightened with the appropriate torque
- Only cables of the appropriate size must be used in the cable glands
- All cable glands must be tightened with the appropriate torque
- All unused cable glands must be sealed or plugged with corresponding stopping plugs

Danger!
Explosion hazard from overvoltage

Using accessories or devices that are not suitable for the specified overvoltage category can 
lead to added voltages. This can result in a voltage flashover generating sparks. The sparks 
can ignite the surrounding potentially explosive atmosphere. 

Ensure that all circuits connected to the device comply with the overvoltage category II (or 
better) according to IEC/EN 60664-1. 

Danger!
Danger to life from using damaged or repaired devices.

Using a defective or repaired device can compromise its function and its electrical safety.

 Do not use a damaged or polluted device.
 The device must not be repaired, changed or manipulated.
 If there is a defect, always replace the device with an original device from Pepperl+Fuchs.
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The enclosure has a degree of protection of IP65 and is designed for wall mounting (mounting 
accessories and tools not included). See table "Installation torque for cable glands and 
enclosure cover" on page 31

Required tools:
 2 screws (M6)
 Drill
 Screwdriver

Depending on the mounting surface, you may need additional mounting material.

Figure 3.8 Mounting holes and enclosure screws

Mounting the Gateway
1. Drill 2 holes into the mounting surface so that they match the holes of the enclosure.
2. Screw the device to the mounting surface using M6 screws.

3.5 Preparing Ethernet Connection
The WirelessHART gateway is equipped with a galvanically isolated Ethernet interface. Note 
that the maximum length of the cable running from the WirelessHART gateway to the Ethernet 
access point is 100 m or less, depending on the cable type and transfer rate. Ensure sufficient 
relief of tension on the cables during installation and note the minimum bending radii of the 
cables.

Wiring the Ethernet Interface
1. Unscrew the 4 screws of the enclosure cover and remove the cover.
2. Route the Ethernet cable through the cable gland in the middle of the enclosure of the 

WirelessHART gateway. The permissible cable diameter lies between 6 ... 10 mm.

1 Mounting holes for M6 screws
2 Enclosure screws

2

1 1

2

Danger!
Explosion hazard from connection or disconnection activities

Connection and disconnection of cables or antennas may cause a spark that can ignite a 
potentially explosive atmosphere.

Connect or disconnect cables or antennas only in the absence of a potentially explosive 
atmosphere.
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3. Connect the Ethernet cable to the Ethernet terminal block. Depending on the Ethernet 
access point, use straight-through or crossover wiring.

 The WirelessHART gateway is now connected to the Ethernet network. The yellow 
Ethernet communication status LED starts flashing when a correct HART or EtherNET/IP 
protocol message is received.

4. Tighten the cable glands with appropriate torque. See table "Installation torque for cable 
glands and enclosure cover" on page 31

5. Seal empty cable glands with the provided plugs.
6. Tighten the enclosure cover with appropriate torque. See table "Installation torque for cable 

glands and enclosure cover" on page 31
You do not need a RJ45 plug to connect the Ethernet cable to the WirelessHART gateway. 
However, you need a RJ45 plug at the other end of the cable to connect the cable to an 
Ethernet hub, switch, router, or PC.

Pinout of the RJ45 Plug
There are different standards for the RJ45 plug: T568A and T568B. The difference between 
both standards is that some wires are connected to different pins of the plug.

Straight-Through or Crossover Wiring
Depending on the network topology, use straight-through or crossover wiring to connect the 
WirelessHART gateway to an Ethernet access point. Note that newer Ethernet hubs, switches, 
and routers are able to detect whether straight-through wiring or crossover wiring has been 
used and adjust the pinout automatically if necessary.

Signal Pins Wire color of T568A plug Wire color of T568Bplug
TX+ 1 White/green stripe White/orange stripe
TX- 2 Green Orange
RX+ 3 White/orange stripe White/green stripe

4 Blue Blue
5 White/blue stripe White/blue stripe

RX- 6 Orange Green
7 White/brown stripe White/brown stripe
8 Brown Brown

87654321
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Wiring with a T568A Plug

Witing with a T568B Plug

Terminal block an 
WirelessHART gateway Straight-through Crossover
T1 Brown Brown

White/brown stripe White/brown stripe
T2 Blue Blue

White/blue stripe White/blue stripe
RX- Orange Green
RX+ White/orange stripe White/green stripe
TX- Green Orange
TX+ White/green stripe White/orange stripe
SHD Cable shield Cable shield

Terminal block an 
WirelessHART gateway Straight-through Crossover
T1 Brown Brown

White/brown stripe White/brown stripe
T2 Blue Blue

White/blue stripe White/blue stripe
RX- Green Orange
RX+ White/green stripe White/orange stripe
TX- Orange Green
TX+ White/orange stripe White/green stripe
SHD Cable shield Cable shield
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3.6 Preparing RS-485 Connection
The WirelessHART gateway is equipped with a fully galvanic isolated RS-485 interface. Note 
that the maximum length of the cable running from the WirelessHART gateway to the process 
control system is 1200 m or less, depending on the cable type and transfer rate. Use shielded 
twisted pair (STP) cables only. Ensure sufficient relief of tension on the cables during 
installation and note the minimum bending radii of the cables.

Wiring the RS-485 Interfaces
1. Unscrew the 4 screws of the enclosure cover and remove the enclosure cover.
2. Route a shielded twisted pair cable through the first cable gland from the left on the bottom 

of the enclosure. The permissible cable diameter lies between 6 ... 10 mm.
3. Connect the shielded twisted pair cable to the first RS-485 terminal block.
4. For a daisy-chain connection, route the second shielded twisted pair cable through the 

second cable gland from the left on the bottom of the enclosure. Connect the second 
shielded twisted pair cable to the second RS-485 terminal block.

5. If the RS-485 bus ends at the WirelessHART gateway, set DIP switch number 7 to "ON" to 
activate the terminator. 

 The WirelessHART gateway is now connected to the RS-485 network. The yellow RS-
485 communication status LED starts flashing when a message is received.

6. Tighten the cable glands with appropriate torque. See table "Installation torque for cable 
glands and enclosure cover" on page 31

7. Seal empty cable glands with the provided plugs.
8. Tighten the enclosure cover with appropriate torque. See table "Installation torque for cable 

glands and enclosure cover" on page 31

Note!
Terminator
The interface is daisy-chain capable through its duplicated RS-485 terminal block. If the RS-
485 cable ends at the WirelessHART gateway and is not routed to other devices (no daisy-
chain connection), activate the integrated terminator to ensure reliable RS-485 
communication. The terminator can be switched on or off using the operating elements and 
indicators inside the enclosure (see chapter 2.3) or using the serial interface ().

Figure 3.9 RS-485 interfaces

1. First RS-485 interface
2. Second RS-485 interface

Note!
Grounding
If the cable shield is grounded, the grounding should only be connected to one end of the 
cable, in order to avoid equipotential bonding currents.
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Gateway Wiring (RS-485 Connection)

3.7 Connecting to Power Supply and Grounding

There are two 24 V DC power supply terminal blocks located inside the WirelessHART 
gateway, allowing for redundant power supply. Open the enclosure cover to access the 
terminal blocks.

Figure 3.10 Power supply

1. First power supply connection
2. Second (redundant) power supply connection
3. Ground connection

Wire RS-485 cable Terminal WHA-GW Meaning
RxD/TxD - (RS-485 A) A RS-485 differential signal
RxD/TxD + (RS-485 B) B
Shield SHD Cable shielding

Danger!
Explosion hazard from premature powering

Powering parts of the system during installation or maintenance leads to added currents. This 
very likely results in a current flashover generating sparks. The sparks can ignite the 
surrounding potentially explosive atmosphere. 

Prior to installation and maintenance activities, ensure that the device is disconnected from the 
power supply. Activate the power supply only after all the circuits required for operation have 
been fully assembled and connected 

Note!
Ensure sufficient relief of tension on the cables during installation and note the minimum 
bending radii of the cables.
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Connecting to Power Supply and Grounding
1. Connect one of the grounding terminals to a ground wire.   see Figure 3.10 on page 30
2. Unscrew the 4 screws of the enclosure cover.   see Figure 3.8 on page 26
3. Remove the enclosure cover.
4. Ensure that appropriate power is supplied.
5. Draw the power cable through the second cable gland from right. 

The permissible cable diameter lies between 6 ... 10 mm.
6. Connect the power cable to the first power supply connection "Line 1" observing polarity.  

 see Figure 3.10 on page 30
7. If you want to connect a redundant power supply (optional), draw the second power cable 

through the cable gland on the far right of the enclosure.
8. Connect the second power cable to the second power supply connection "Line 2" 

observing polarity.
 The WirelessHART gateway is connected to power supply.

9. Tighten the cable glands with appropriate torque. See table "Installation torque for cable 
glands and enclosure cover" on page 31

10.Seal empty cable glands with the provided plugs.
11.Tighten the enclosure cover with appropriate torque. See table "Installation torque for cable 

glands and enclosure cover" on page 31

Installation torque for cable glands and enclosure cover

Note!
The tightening torques of cable glands depend on what type of cable is used and must 
therefore be determined by the user. The cap nuts must be securely tightened. Tightening the 
cap nuts too tight can have a negative effect on the protection class. The following figures 
should be taken as rough guides only.

Installation torque cable 
glands

Type of cable glands

2.5 Nm Plastic
4.11 Nm Nickel plated brass
4.11 Nm Stainless steel
Installation torque enclosure cover
2.5 Nm
Table 3.1 Installation torque for cable glands and enclosure cover
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4 Commissioning
4.1 Important Steps to Getting Started

Connection and configuration can be performed in two different ways:

 DTM software
 Web interface

Configuration via DTM Software
1. Install the DTM software and related components (if required): Microsoft® .NET Framework, 

PACTware® Framework, DTM Collection, HART Communication DTM.
2. Connect to the WirelessHART Gateway via RS485 or Ethernet.

3. Create a new PACTware® project.

4. Configure the WirelessHART Gateway using the PACTware® or a similar framework 
application.

Configuration via Web Interface
1. Download and install a web browser (if required).
2. Connect to the WirelessHART Gateway via Ethernet.
3. Configure the WirelessHART Gateway using the web interface.

4.2 DTM Software
4.2.1 Downloading DTM Software Components

Required software:

 Microsoft® .NET Framework

 PACTware® Framework
 WirelessHART DTM

The DTM collection including WirelessHART device DTMs and Ethernet communication 
DTM.

 HART CommDTM
The HART CommDTM has to be installed separately if serial HART communication via 
the RS-485 interface of the WirelessHART Gateway is required. The HART CommDTM 
supports both FSK (i.e. HART modem) and RS-485 interfaces.

Download Software
1. Go to www.pepperl-fuchs.com and scroll down to the bottom of the page until you see the 

area Pepperl+Fuchs International site links.
2. Click Process Automation.
3. Click Software in the Process Automation Products menu on the left.
4. Click Download Software to download the following components: 

Microsoft® .NET Framework, PACTware®, WirelessHART DTM and, if required, the 
HART CommDTM. You might need to scroll down the page to find the required 
component.

Note!
If one of the software components is already installed on your system, the installation may be 
omitted.

http://www.pepperl-fuchs.com
http://www.pepperl-fuchs.com
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4.2.2 Installing the DTM Software Components
Your computer must meet the following requirements in order to run PACTwareTM and the 
device DTM:

 Operating system: Windows® 2000 Service Pack 4, Windows® XP Service Pack 1/2/3 or 
Windows® Vista

 Software: Microsoft® .NET Framework Release 1.1 Service Pack 1
 Processor: 500 MHz or faster
 Memory: 256 MB RAM or more
 Disk space: 200 MB or more
 Graphics resolution: 1024 x 768 or higher
 Administrator privileges to enable software installation

Install the DTM Software Components
1. Install the Microsoft® .NET Framework by starting the corresponding setup.exe file and fol-

lowing the installation instructions given on the screen.

2. Install PACTwareTM by starting the corresponding setup.exe file and following the 
installation instructions given on the screen.

3. Install the WirelessHART DTM collection by starting the corresponding setup.exe file and 
following the installation instructions given on the screen.

4. Install the HART CommDTM by starting the corresponding setup.exe file and following the 
installation instructions given on the screen.

 You have installed the required software.
4.2.3 Updating the DTM Catalog

Once you have installed the FDT base application and the Device Type Manager (DTM) on the 
computer, the FDT base application's DTM catalog must be updated. The PACTwareTM DTM 
catalog is called "Device Catalog" and is normally automatically updated when PACTwareTM is 
launched.

If PACTwareTM does not update the device catalog automatically, proceed as follows.

Updating the Device Catalog
1. Start PACTwareTM.
2. Select View > Device Catalog or click Device Catalog in the icon bar.

 The Device Catalog window opens.
3. Click Update Device Catalog to update the device catalog.
4. Click Yes to continue.

 The updated device catalog appears.
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4.3 Discovery and Configuration Tool
4.3.1 Download Discovery and Configuration Tool

Download Software
1. Go to www.pepperl-fuchs.com and scroll down to the bottom of the page until you see the 

area Pepperl+Fuchs International site links.
2. Click Process Automation.
3. Click Software in the Process Automation Products menu on the left.
4. Click Download Software to download the Discovery and Configuration Tool for the 

WirelessHART Gateway. You might need to scroll down the page to find the required 
software.

4.3.2 Install the Discovery and Configuration Tool
Install the Discovery and Configuration Tool
1. Go to the directory that includes the installation file and start the installation wizard.
2. Follow the instructions of the installation dialog.
3. Choose Finish to leave the installation wizard.

 The Discovery and Configuration Tool has been installed and is ready for use.
4.3.3 Detect IP Address of the WirelessHART Gateway

By default, the IP address of the WirelessHART Gateway is automatically assigned via DHCP. 
The Discovery and Configuration Tool enables you to scan the Ethernet network and detect 
the current IP address of the WirelessHART Gateway. Furthermore, you can use the Discovery 
and Configuration Tool to resolve an improper network configuration, for example, if an IP 
address collision has been detected.

Detect IP Address and Update Network Configuration
1. Make sure your PC is connected to the Ethernet network that the WirelessHART Gateway is 

connected with.
2. Start the Discovery and Configuration Tool.

 The Discovery and Configuration Tool opens.

Figure 4.1 Pepperl+Fuchs Configuration Tool

Note!
If the Discovery and Configuration Tool is already installed on your system, the installation may 
be omitted.

Tip
Note that the WirelessHART Gateway is always accessible via the Discovery and 
Configuration Tool, even in case of errors.

http://www.pepperl-fuchs.com
http://www.pepperl-fuchs.com


WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Commissioning

 2
01

9-
06

35

3. The Discovery and Configuration Tool automatically scans the Ethernet network.
 If the WirelessHART Gateway is located in the same subnet, the Discovery and 

Configuration Tool displays the current IP address of the WirelessHART Gateway in the IP 
Address column.

4. If the WirelessHART Gateway is not located in the same subnet, click Connect to 
Subnet... and enter the IP address of a gateway in the subnet, which then acts as a proxy 
for all gateways in the subnet.

 The Discovery and Configuration Tool displays the current IP address of the 
WirelessHART Gateway in the IP Address column.

5. To change the configuration of the WirelessHART Gateway, select the WirelessHART 
Gateway from the list and click Edit Configuration.

 The Edit Configuration window enables you to update the network connection.

4.4 Connecting via RS-485
Once the WirelessHART gateway has been connected to the RS-485 bus, you can connect 
the RS-485 bus to your PC. This can be done by using an RS-485 to RS-232 converter or 
using an RS-485 to USB converter.

Connect the RS-485 Bus to your PC
1. Connect the RS-485 to RS-232 converter or the RS-485 to USB converter to your PC.

2. To find out to which COM port the converter is connected, open the Windows® device 
manager. Click Windows Icon > Control Panel > System > Device Manager.

3. Under Ports (COM & LPT) you see the converter and its COM port. Make a note of the 
COM port number. You will need the COM port number when setting up the communication 
DTM for the RS-485 connection.

Figure 4.2 USB converter in device manager

Note!
The usage of an approved RS-485 converter is recommended for faster configuration and 
more reliable high-speed operation. In addition, the usage of a galvanically isolated RS-485 
converter is strongly recommended for permanent installations.
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4.5 Connecting via Ethernet
By default, the IP address of the WirelessHART Gateway is automatically assigned via DHCP. 
Depending on whether a DHCP server is available or not, you have two options to connect 
your PC to the WirelessHART Gateway via Ethernet:

 DHCP server available
If the WirelessHART Gateway and your PC are connected to an Ethernet network, use 
the Discovery and Configuration Tool to scan the Ethernet network and detect the current 
IP address of the WirelessHART Gateway. See chapter 4.3.3
Using this IP address, you can connect to the WirelessHART Gateway via Ethernet.

 No DHCP server available
If the WirelessHART Gateway is directly connected to your PC, use the Discovery and 
Configuration Tool to define a static IP address and subnet mask for the WirelessHART 
Gateway that matches the local area network settings of your PC. See chapter 4.3.3
Using the static IP address of the WirelessHART Gateway, you can connect to the 
WirelessHART Gateway via Ethernet.

4.6 Creating a new Project in PACTwareTM

4.6.1 Creating a New Project

Creating a new project in PACTwareTM?

Select File > New or click Create New Project.

 A new, unnamed project appears in the main window. The project initially consists of the 
entry HOST PC.

4.6.2 Adding the Communication DTM
A communication DTM is an interface between the FDT frame application and the device DTM. 
The communication DTM enables communication between the device DTM and the device 
connected to the PC.

Depending on how your PC is connected to the WirelessHART Gateway (via RS485 or 
Ethernet), you need to add a corresponding communication DTM to your PACTware project. 
The RS485 communication DTM is the HART Communication DTM, and the Ethernet 
communication DTM is called HART IP Communication.

Adding HART Communication DTM

1. Select HOST PC in the project view.

2. Choose Device > Add device or click Add device .
3. Select the entry HART Communication and click OK.

 The HART Communication DTM is added to the project.

Figure 4.3 HART Communication DTM in project view

Note!
The HART Communication DTM is not included in the WirelessHART DTM Collection. It can 
be downloaded separately from www.pepperl-fuchs.com.

http://www.pepperl-fuchs.com
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4. To edit the parameters, right-click the HART communication DTM and select Properties.
5. Set the parameters according to the following table.
6. Click OK to save the changes and to close the parameter window.

Adding HART IP Communication DTM
1. Select HOST PC in the project view.

2. Choose Device > Add device or click Add device.
3. Select the entry HART IP Communication.
4. Click OK.

 The HART IP Communication DTM is added to the project.

Figure 4.4 HART IP Communication DTM in project view

5. To edit the parameters, right-click HART IP Communication and select Properties.
6. Set the parameters according to your preferences. In most cases, the default values should 

be fine.
7. Click OK to save the changes and to close the Properties window.

Parameter Description Default
Communica
tion 
interface

Set this parameter to HART multiplexer. HART 
modem

Port Set this parameter to the COM port your 
RS485–RS232 converter or your RS485–USB converter is 
connected to. See chapter 4.4

COM1

Baudrate Set the baudrate according to the settings of the baud rate of the 
WirelessHART Gateway. The baud rate of the WirelessHART 
Gateway can be adjusted via the DIP switches inside the housing 
or via software. See chapter 2.3

19200

RTS 
Control

Depending on the RS485–RS232 converter used, it may be 
necessary to switch on or off the request-to-send control in order 
to be able to switch over correctly between reception and 
transmitting mode

Toggle

Master Specify if you want the WirelessHART Gateway to be the primary 
or the secondary master. If, for example, there already is a 
primary master connected, you have to choose Secondary 
master.

Primary 
Master

Preamble Number of preambles for HART communication. 5
Number of 
communica
tion retries

The number of retries for HART communication in case of an 
error.

3

Start 
address

Here the address range is set, in which the HART 
Communication DTM is to search for HART Multiplexers 
connected to the RS-485 bus.

0

End 
address

15



 2
01

9-
06

38

WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Commissioning

Edit DTM Addresses of the Ethernet Communication DTM
1. Right-click HART IP Communication.
2. Choose Additional Functions > Set DTM addresses.

 The Set DTM addresses window is displayed.

Figure 4.5 Set DTM address window

3. Change the parameters as required (see following table).
4. Click Update changed data to apply the new settings.
5. Disconnect and re-establish the connection between the DTM and the WirelessHART 

gateway to activate the new settings.

HART IP communication DTM WirelessHART gateway
Parameter Explanation Default Parameter Default
Tag Gateway name in the 

Project view of 
PACTware. Any name may 
be entered (not relevant for 
connection to the 
WirelessHART gateway)

WHA-GW – –

Bus Address Gateway polling address
Must match the settings of 
the WirelessHART 
gateway.

1 Parameterization > 
Wired Communication > 
Protocols > HART > Bus 
Address

1

UDP 
Address

Gateway IP address
Must match the settings of 
the WirelessHART 
gateway.

192.168.0
01.001

Parameterization > 
Wired Communication > 
Interfaces > Ethernet > 
IP Address

192.168.0
01.001

UDP Port Gateway port number 
(HART over UDP)
Must match the settings of 
the WirelessHART 
gateway.

5094 Parameterization > 
Wired Communication > 
Protocols > HART > Port 
Number

5094
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4.6.3 Devices
After you have added a communication DTM, add the devices for the WirelessHART gateway.

Adding Devices
1. In the project view, right-click on the entry of the communication DTM.
2. To add a device to the project, choose Add device.
3. Select the entry WHA-GW.
4. Click OK.

 The device for the WirelessHART gateway is added to the project.

Figure 4.6 New device below HART IP Communication DTM in project tree

Topology Scan
The DTM provides a topology scan wizard to detect and store the device structure of the 
scanned network in an FDT project. The scan is performed independently on each level for the 
communication DTM, the WirelessHART gateway, and the devices.

Topology Scan: Creating the Project Tree Online
You can create the complete project tree for communication DTMs using the topology scan. 
The following example shows how to create a project tree for the HART IP Communication 
DTM. Ensure that you have added HART IP Communication DTM to the project tree. Ensure 
that the HART IP Communication DTM remains active, and proceed as follows:

1. Right-click on the HART IP Communication DTM, and go to Topology Scan. 

Tip
After you have added the device for the WirelessHART gateway, you can easily add other 
WirelessHART devices by performing a topology scan. To do so, right-click the WirelessHART 
gateway and select Connect. When you have an active connection to the WirelessHART 
gateway, right-click the WirelessHART gateway and select Topology Scan.

Note!
Note on Hardware Version
Automatic topology scanning is possible with the WirelessHART gateway, revision 3 or higher. 
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 The topology scan wizard opens.
2. Optionally, you can make settings for the HART IP communication DTM: In the Scan Tree, 

right-click onto the HART IP Communication DTM. From the context menu that opens, 
select DTM Functions > Parameter. In the Settings section on the right, for the HART IP 
Communication DTM enter a suitable project tag, determine the communication timeout, 
and the number of retries. 

Figure 4.7 Parameter > DTM Functions for HART IP Communication DTM 
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3. In order to start the topology scan, click on the blue single arrow (1) in the lower left section 
of the wizard dialog.

 Scanning is indicated by a status bar. All gateways on the network are listed. All devices 
that are connected to the gateways are listed. As scanning takes place, the Scan Tree 
section fills with all the detected participants of network, at the same time the project tree is 
updated.

Figure 4.8 Topology scan: Filling up project tree while scanning 

4. Close the topology scan wizard.
 Your FDT project tree is complete.

1
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Rescanning in Case of Failed Device Detection
In case the topology scan cannot detect any connected devices, ensure that all devices are 
switched on. Then you can manually rescan the topology as follows:

1. Manually rescan the WirelessHART adapter. Assign a device type and a semantic ID man-
ually. Confirm by clicking on Apply. 

Figure 4.9 Topology scan wizard: Issues after completing the scan, in general unkown devices 
on the network

2. Close the topology scan wizard.
 Your FDT project tree is complete.
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5 Configuration via Web Interface
When configuring the WirelessHART gateway via the web interface, the WirelessHART 
gateway must be connected to your PC via Ethernet.

Log in to the Web Interface
1. Start your web browser.
2. If your web browser uses a proxy, deactivate the proxy.
3. Type the IP address of the WirelessHART gateway into the address field. The default IP 

address is 192.168.001.001. If you changed the IP address of the WirelessHART 
gateway, type in the new IP address.

 Depending on the security settings of your web browser, you may see a security 
warning. In this case, click OK and proceed to the login screen.

Figure 5.1 Entering login data for secure connection

4. Either log in as user/operator or as administrator. Enter your user name and password. The 
default user is admin and the default password is admin.

5. Click OK.

5.1 Identification Parameters
The identification parameters provide various information about the device and identify the 
device within the network.

Figure 5.2 Parameter > Identification
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Identification Parameters

5.2 Wireless Communication Parameters
5.2.1 Setup

The setup parameters contain the necessary information for establishing and maintaining a 
WirelessHART network.

Figure 5.3 Parameter > Wireless Communication > Setup

Parameter Description Default
Device Long 
Tag

Identifies the device in a WirelessHART network. Enter up to 
32 characters.

–

Device Tag Identifies the field device within the process plant. Enter up to 
8 characters.

–

Descriptor Further description of the device. Enter up to 16 characters. –
Date User-defined date (e.g. last parameter change). Format: 

DD.MM.YYYY
The Date parameter is not modified by the WirelessHART 
gateway. It must be set by the user or a host application.

–

Message User-defined message. Enter up to 32 characters. –
Country 
Code

Select the country code of the country in which the device is 
operated from this drop-down list. 

–

Table 5.1 Identification Parameters
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Changing the Join Key throughout the Network

1. In the web interface, go to Wireless Communication > Setup.

Figure 5.4 Wireless Communication > Setup

2. In order to change join key on all devices throughout the network: Use the Join Key Part 
1 ... 4 of 4 (HEX) fields.
Use the double arrow buttons to Write the Join Information.

 A status message will inform you whether the procedure was successful. If a problem 
occurred a NE 107 maintenance symbol will be displayed in the lower status bar. Clicking 
on the symbol will provide you with information on the problem. For more information on the 
NE 107 symbols, see chapter 5.2.2

Note!
Prerequisites
In order to change the join key  network password parameter, activate the security mode with a 
DIP switch inside the enclosure of the WirelessHART gateway. Set the DIP switch 8 to ON.   
see Figure 2.6 on page 16
In the security mode, the CMD 768 HART command can be used to set the join key of the 
WirelessHART gateway as required.

Tip
Re-Joining Devices with Issues
For an overview of all devices in the network go to Wireless Communication > Operating 
Modes. NE 107 status information symbols inform on the status of each device in the network.
In order to access a device that is temporarily out of operation or needs maintenance, use the 
join key that was previously used when this device was active in the network. The old join key 
allows the device to re-join the network without having to change it.
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Setup Parameters

Caution!
Network security risk

For security reasons do not use the security mode connection as a normal communication 
channel. After having changed the join key, disable the security mode using the DIP switch 
(DIP switch 8 = OFF).

Caution!
Possible loss of connection when changing Network ID

If you change the Network ID parameter of an already operating WirelessHART network, the 
WirelessHART gateway stores the new network ID and applies the network ID the next time 
the network is reformed (note that reforming the network can take a long time). When the new 
network ID becomes active, the connection to other WirelessHART devices can get lost.

When changing the network ID in the WirelessHART gateway, write the new network ID to 
each wireless device in the network using either the wired or the wireless connection. Again, 
the new network ID is stored in the device and is applied the next time the network is reformed.

Parameter Description Default
Network Tag Identifies the device in a WirelessHART network. Enter up to 

32 characters.
–

Network ID Each wireless device needs to store a network ID to identify 
the WirelessHART gateway it is expected to connect to. 
Enter up to 5 digits. The network ID may range from 
0 ... 65535.
Press Write Join Information to store the new network ID to 
the WirelessHART gateway. Remember to change the 
network ID of the other wireless devices in the network, too.
The network has to be reformed before the new network ID 
takes effect. To reform the network, choose Reform 
Network in the Additional Functions > Reset menu.

1945

Join Key Part 
1 ... 4

The join key is a common network password. Each wireless 
device needs this join key to be allowed to join the network.
The join key consists of up to 32 hexadecimal characters 
(0 ... 9, a ... f). There are 4 text fields. Enter up to 8 
hexadecimal characters into each text field. Each text field 
must contain the same number of characters (e.g., 5 each).
Press Write Join Information to store the new join key to the 
WirelessHART gateway.
This parameter can only be edited if the security mode is 
activated by means of a DIP switch.   see Figure 2.6 on 
page 16
In order to change the join key, in the gateway web interface 
go to Wireless Communication > Setup and change the 
join key in the Join Key Part 1 ... 4 of 4 (HEX) fields.
A status message will inform you whether the procedure was 
successful. 
If the join key is changed, the currently joined wireless 
devices will remain connected with the network. However, no 
device will be allowed to join unless it stores the new join key.
Available only online.

E090D6E2
DADECE94
C7E9C8D1
E781D5ED

Write Join 
Information

Stores the Network ID and Join Key to the WirelessHART 
gateway. Please read the information related to the network 
ID and join key in this section including the security notes.
Available only online.

RTC Date Real-time clock (RTC) date setting for the network. Enter a 
date in the following format: DD:MM:YYYY.
Available only online.

–
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You can use the Channel Blacklist to disable selected channels. If there are other wireless 
networks in the area where the WirelessHART network is located, you can make sure that 
channels are not used by multiple networks at a time.

Figure 5.5 Channel Blacklist

RTC Time Real-time clock (RTC) time setting for the network. Enter a 
time in the following format: hh:mm:ss.
Available only online.

–

Network start 
date

Shows the date at which the network was (re)started.
Available only online.

–

Network start 
time

Shows the time at which the network was (re)started.
Available only online.

–

Allow new 
Devices

Specify if new devices are allowed to join the WirelessHART 
network.

all

Radio Power Power level of the radio transmitter of the WirelessHART 
gateway, which should normally be set to 10 dBm. Observe 
local restrictions for 2400 MHz equipment.

10 dBm

Bandwidth 
Profile

This option allows you to increase network performance by 
reducing the latency, which increases the energy 
consumption and reduces battery life of the network 
components. We recommend that you use the medium and 
high performance profiles if latency reduction is more 
important than battery life.
The network has to be reformed for the new bandwidth profile 
to become active. To reform the network, choose Reform 
Network in the Additional Functions > Reset menu.

Normal 
Bandwidth 
Profile

Global 
Advertising 
Timeout

If Global Advertising is activated, the WirelessHART 
gateway and the network components will send a series of 
identification messages at a frequency higher than normal to 
identify new wireless devices and to reduce the network join 
time. The messages are sent until the Global Advertising 
Timeout is reached.
Enter the timeout in minutes. The timeout may range from 
1 ... 255 minutes.

–

Activate 
Global 
Advertising

If activated, the network manager sends advertising 
messages to announce the network’s existence. When a 
WirelessHART field device receives such an advertising 
message, it tries to join the network.
Enabling Global Advertising increases energy consumption 
of the network components. Therefore we recommend that 
you use this features only if needed, for example if you expect 
new devices to join the network. Note that you can activate 
Global Advertising without reforming the network.

Table 5.2 Setup Parameters

Parameter Description Default
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Create Channel Blacklist
1. To disable a channel, deactivate its check box in the Channel Blacklist area. Note that at 

least 5 channels must remain active.
2. Click Send to Device to transfer the updated blacklist settings to the WirelessHART 

gateway. Note that the WirelessHART gateway stores the updated blacklist but does not 
apply the updated settings unless the network is reformed.

3. Go to Additional Functions > Reset and click Reform Network to apply the updated 
channel blacklist.

5.2.2 Operating Modes
The Operating Modes table displays all devices of the WirelessHART network and their 
operation modes. It represents the virtual I/O system of the WirelessHART gateway. See 
chapter 2.1.3

Whenever a wireless device joins the network, it is automatically inserted into the Operating 
Modes list if it is not already existing. Wired devices connected to a WirelessHART adapter will 
also be inserted.

Figure 5.6 Parameter > Wireless Communication > Operating Modes

If required, click Refresh to reload the operation mode parameters of all devices.

Example!
Note that a WLAN channel based on the IEEE 802.11 standard is wider than a WirelessHART 
channel based on the IEEE 802.15.4 standard. If running a WirelessHART network in such an 
area, we recommend that you also disable adjacent channels. For example, if channel 5 is 
already occupied by a wireless network based on the IEEE 802.11 standard, we recommend 
that you disable the WirelessHART channels 4, 5, and 6.

Note!
In addition to the manual channel selection, the WirelessHART network adapts the channel 
usage dynamically to new situations, for example if a new wireless network is installed in the 
area where the WirelessHART network is located.
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General Data

Caution!
System failure

If you click Refresh right after the device was switched on or reset, the system may stop 
responding.

If the device was switched on or reset, wait about 1 minute until the boot process is complete 
before you click Refresh.

Note!
If using the DTM and PACTware to configure the WirelessHART gateway, the following data is 
available only during online parameterization.

Displayed 
Information Description
Long Tag Displays the long tag of the device.

HART 5 devices and older devices do not support long tags. For those 
devices, the WirelessHART adapter uses the content of the Message field 
which will be displayed here instead.

I/O Card Indicates the virtual I/O card number to which the device is mapped to. See 
chapter 2.1.3

Channel Indicates the channel of the virtual I/O card that the device is mapped to. See 
chapter 2.1.3
The value 0 identifies a WirelessHART device or a WirelessHART adapter, 
while the value 1 identifies a wired device connected to a WirelessHART 
adapter.

Device Type Displays the device type as registered at the HCF.
Status The following communication statuses exist:

communication not possible
communication possible, device not identified
(flashing) communication possible, identification ongoing

device connected and identified
Dev. Status Note that the device status displayed in the list may differ from the actual 

device status because the HART status bits may be interpreted differently.
The following device statuses exist:

maintenance required
out of specification
check function

failure
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Operating Mode Parameters
Parameter Description
Routing 
Device

Indicates whether the device is allowed to act a routing device. This option 
enables you to set up a star network, or to increase the battery life of certain 
devices.
To deactivate the routing functionality, deactivate the corresponding check 
box in the Routing Device column.
The network has to be reformed before the activated/deactivated routing 
functionality takes effect. To reform the network, choose Reform Network in 
the Additional Functions > Reset menu.

Fast Pipe This option establishes a direct connection to a selected device. The fast pipe 
connection is about 4 times faster than a regular connection, which enables 
you to perform fast updates.
To establish a direct connection to a selected device, activate the Fast Pipe 
check box. Note that you can activate the Fast Pipe option only for one 
device at a time.

Flush Cache This option deletes the cache of the received HART commands.
Note that the measured values will not be deleted to allow host applications to 
work with the last measured values.

Force 
Identification

This option forces a device to resend its identification, for example if a 
communication failure occurred.
Note that this option is available only for devices that have not been identified 
yet.

Delete 
Device To remove a device from the list, click the X-sign at the end of the row.

Note that this option is available only for devices that have no connection to 
the network.

Table 5.3 Operating Mode Parameters
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5.3 Wired Communication Parameters

5.3.1 Serial Interface
The WirelessHART gateway can connect to the host system via an Ethernet interface or a 
serial interface. This section describes the parameters for the serial interface.

Figure 5.7 Parameter > Wired Communication > Interfaces > Serial

Serial Interface Parameters

5.3.2 Ethernet Interface
The WirelessHART gateway can connect to the host system via an Ethernet interface or a 
serial interface. This section describes the parameters for the Ethernet interface.

Note!
If you are connected to the WirelessHART gateway via Ethernet using the HART IP 
communication DTM, make sure to update the parameters of the HART IP communication 
DTM when changing the following parameters of the WirelessHART gateway.

 Parameterization > Wired Communication > Interfaces > Ethernet > IP Address
 Parameterization > Wired Communication > Protocols > HART > Bus Address
 Parameterization > Wired Communication > Protocols > HART > Port Number

Parameter Description Default
Termination 
Resistor 
Selection

Select if you prefer to activate the termination resistor of the 
WirelessHART gateway via the DIP switches inside the 
enclosure (see chapter 2.3) or via software.

DIP switches

Termination 
Resistor

Connect or disconnect the termination resistor of the 
WirelessHART gateway. This drop-down list depends on the 
value of Termination Resistor Selection. If the value of 
Termination Resistor Selection is "DIP switches", this 
checkbox is read only.

Disconnected

Table 5.4 Serial Interface Parameters
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Figure 5.8 Parameter > Wired Communication > Interfaces > Ethernet

Ethernet Interface Parameters

Caution!
Possible loss of Ethernet connection

After enabling DHCP using the IP address assignment (DHCP) parameter, the host can lose 
the Ethernet connection due to the new, automatically assigned IP address.

Parameter Description Default
IP 
configuration 
mode (DHCP, 
DNS)

Select Manually to configure the IP address, gateway 
address, and Domain Name Server (DNS) manually, or 
select Automatic to enable automatic configuration via the 
Dynamic Host Configuration Protocol (DHCP) server. If you 
choose Automatic, all other input fields in the window will be 
grayed out (read only).

Manually

IP Address If using manual configuration, enter the IP address of the 
WirelessHART gateway.

192.168.1.1

Netmask If using manual configuration, enter the subnet mask. 255.255.255.0
Gateway 
address

If using manual configuration and if necessary, specify the IP 
address of the WirelessHART gateway in the IP network.
Note that this is not the IP address of the WirelessHART 
gateway. If changing the gateway address, it can take up to 
10 seconds for the changes to take effect.

0.0.0.0

DNS 1 If using manual configuration, enter the address of the first 
Domain Name Server (DNS 1).

0.0.0.0

DNS 2 If using manual configuration, enter the address of the 
second Domain Name Server (DNS 2).

0.0.0.0

MAC Address Displays the MAC address of the WirelessHART gateway. 
Note that the MAC address is a characteristic of the device 
itself and cannot be changed. Each device has a unique MAC 
address.

Write 
Ethernet 
Information

Applies the current Ethernet settings from above to the 
WirelessHART gateway.

Table 5.5 Ethernet Interface Parameters
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5.3.3 HART Protocol
The protocol parameters configure the HART protocol that run over the serial interface or the 
Ethernet interface.

Figure 5.9 Parameter > Wired Communication > Protocols > HART

HART Parameters
Parameter Description Default
Serial
Bus Address 
Selection

Select DIP switches to specify the polling address of the 
WirelessHART gateway using the DIP switches inside the 
enclosure (see chapter 2.3) or select Software to specify the 
polling address in the following field.

DIP switches

Bus Address  If Bus Address Selection is set to DIP switches, this is 
a read-only field.

 If using the DTM and PACTware® for specifying the 
polling address, this field is a read-only field and you must 
enter the polling address in the HART IP 
Communication DTM. See chapter 6.1

 If using the web interface for specifying the polling 
address, enter the polling address for the WirelessHART 
gateway.

0

Baud Rate 
Selection

Select DIP switches to specify the baud rate of the 
WirelessHART gateway using the DIP switches inside the 
enclosure (see chapter 2.3) or select Software to specify the 
baud rate in the following field.

DIP switches

Baud Rate If using the DTM or web interface for specifying the baud rate, 
select the baud rate for the WirelessHART gateway from the 
drop-down list. If Baud Rate Selection is set to DIP 
switches, this parameter is read only.

19200

Ethernet
Port Number Enter the port number of the WirelessHART gateway (HART 

over UDP, Ethernet Interface).
5094
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5.3.4 Emerson AMS Integration
Integration in the Emerson AMS Suite is performed via Ethernet.

Figure 5.10 Parameter > Wired Communication > Protocols > AMS

AMS Parameters

5.3.5 Number of Clients on Ethernet Interface
You can access the WirelessHART Gateway with multiple clients in parallel, depending on the 
port configuration of the WirelessHART Gateway.
If you change the Ethernet port for the HART protocol, the default port remains open and 
active. Due to this behavior it is possible to communicate with the WirelessHART Gateway 
over the default port (5094) and a user-defined port in parallel.

To change the Ethernet port for the HART protocol, .

5.4 Diagnostics
The Diagnostics function provides detailed information about the device, wireless/wired 
communication and health status.

Tip
If you change the Ethernet port for the HART protocol, the default port remains open and 
active. Thus, you can communicate with the WirelessHART gateway over the default port 
(5094) and a user-defined port in parallel. Note that this behavior applies only for the HART 
protocol (not for the EtherNet/IP protocol).

Parameter Description Default
Port number Enter the port number under which the AMS will address the 

WirelessHART gateway.
33333

Note!
Note that this behavior applies only to the Ethernet port for the HART protocol.

Note!
Available Only Online (DTM)
If using the configuration via DTM and PACTware the Diagnostics function is available only 
online. See chapter 6.4
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Accessing the Diagnostics Window
1. If using the DTM and PACTware, right-click the device in the project tree and select Diag-

nostics.
2. If using the web interface, select Diagnostics in the navigation area on the left.

5.4.1 Identification
Here you find information about the WirelessHART gateway.

Figure 5.11 Diagnostics > Identification

Identification Information
Parameter Description
Device Long 
Tag

Identifies the device in a WirelessHART network.

Device Tag Identifies the field device within the process plant.
Descriptor Further description of the device.
Date User-defined date (e.g. last parameter change). Format: DD.MM.YYYY

The Date parameter is not modified by the WirelessHART gateway. It must 
be set by the user or a host application.

Message User-defined message.
Universal 
command 
revision

Revision of the universal commands of the device. Only available online.

Device 
Revision

Revision of the device-specific commands. Only available online.

Software 
Revision

Software revision of the device. Only available online.

Country 
Code

Country code of the country in which the device is operated (user-defined).

Assembly 
Number

The assembly number of the WirelessHART gateway. Only available online.

Table 5.6 Identification Information
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5.4.2 Wireless Communication

Overview
The overview screen provides information about the I/O interfaces of the wireless network as 
well as network statistics.

Figure 5.12 Diagnostics > Wireless Communication > Overview

Overview Information
Displayed 
Information Description
I/O System Capabilities
Max. Card 
Number

Displays maximum number of cards in the I/O system. This corresponds to 
the maximum number of wireless devices that can be connected to the 
WirelessHART gateway.

Max. Channel 
Number

Displays maximum number of channels. The WirelessHART gateway always 
returns the value 2.

Max. Sub Dev. 
Number

Displays maximum number of sub devices that can be connected to a specific 
WirelessHART adapter.

Number of 
Devices

Displays current number of sub devices. Every device counts as a sub 
device, no matter if it is a wireless device or a wired device connected to a 
WirelessHART adapter.

Lifetime Network Statistics
Reliability Percentage of data packets generated by wireless devices that were correctly 

received by the WirelessHART gateway.
Stability Ratio of successful data packet transfers to the total number of data packet 

transfers on all wireless paths in the network.
Latency Average time taken for data packets generated by the wireless devices to 

reach the WirelessHART gateway.
Lost upstream 
packages

Total number of data packets generated by the wireless devices that were 
lost when transferred over the network.

Table 5.7 Overview Information



WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Configuration via Web Interface

 2
01

9-
06

57

Details
The Details table displays all devices of the WirelessHART network including their diagnostic 
information of the last 15 minutes.

Figure 5.13 Diagnostics > Wireless Communication > Details

To show/hide the index number of a device in the structure, deactivate/activate Tree-View. If 
Tree-View is deactivated, the devices are shown in the order they were added to the 
instrument list.

If required, click Refresh to reload the diagnostic details of all devices.

Note!
Diagnostic information is available only after a cycle of 15 minutes has been completed. During 
this time, some information is set to 0 or replaced by wildcard characters.
The diagnostic information represents the last 15 minutes only. Note that for connection paths 
with very low traffic, the validity of the diagnostic information can be poor.

Caution!
System failure

If you click Refresh right after the device was switched on or reset, the system may stop 
responding.

If the device was switched on or reset, wait about 1 minute until the boot process is complete 
before you click Refresh.

Note!
If using the DTM and PACTware to configure the WirelessHART gateway, the following data is 
available only during online parameterization.



 2
01

9-
06

58

WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Configuration via Web Interface

General Data

Diagnostic Information

To export the diagnostic details to a CSV file, click Export (web interface) resp. Export CSV 
(DTM).

For more information on the structure of the CSV file, see chapter 12.

Displayed 
Information Description
Long Tag Displays the long tag of the device.

HART 5 devices and older devices do not support long tags. For those 
devices, the WirelessHART adapter uses the content of the Message field 
which will be displayed here instead.

I/O Card Indicates the virtual I/O card number to which the device is mapped to. See 
chapter 2.1.3

Channel Indicates the channel of the virtual I/O card that the device is mapped to. See 
chapter 2.1.3
The value 0 identifies a WirelessHART device or a WirelessHART adapter, 
while the value 1 identifies a wired device connected to a WirelessHART 
adapter.

Device Type Displays the device type as registered at the HCF.
Status The following communication statuses exist:

communication not possible
communication possible, device not identified
(flashing) communication possible, identification ongoing

device connected and identified
Dev. Status Note that the device status displayed in the list may differ from the actual 

device status because the HART status bits may be interpreted differently.
The following device statuses exist:

maintenance required
out of specification
check function

failure

Parameter Description
Number of 
Joins

Number of times the device has joined the network.

Join Time Date and time of the most recent join.
Reliability Percentage of the data packets generated by the wireless devices that were 

correctly received by the WirelessHART gateway.
Latency Average time taken for data packets generated by the wireless devices to 

reach the WirelessHART gateway.
+ To show/hide the list of neighboring devices, click the + sign in the + column.
Neighbors Lists the neighboring WirelessHART devices in reach of the selected device.
RSSI The RSSI (Received Signal Strength Indicator) indicates the power of the 

received signal for each neighboring device. Note that you must expand the 
list of neighboring devices in order to see the RSSI value for each device.

Stability Ratio of successful data packet transfers to the total number of data packet 
transfers on all wireless paths in the network.

Table 5.8 Diagnostic Information
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Burst Lists
Normally, a HART slave device only responds when being polled by the host. Burst mode is a 
special communication mode in which a HART slave device sends data to a particular HART 
command without being polled by the host. When burst mode is used, a HART slave device 
can publish data (for example process values) autonomously to another device in regular 
intervals. Alternatively, data can be published if the value has changed by a significant amount, 
has reached a certain threshold level, or has not been updated within a default reporting time.

The WirelessHART gateway maintains a burst message list, which lists the specific commands 
that are being published by each device in the WirelessHART network. Note that the burst list 
is reset after power-up or network restart.

Device Publishing Guidelines
 We recommended that you always publish command 48 to ensure caching of the related 

status information. A publishing interval of approx. 1 minute is generally the best choice 
for wireless devices (not for wired devices).
For example, when configuring WirelessHART adapters, command 48 allows proper 
identification and management of changes in the sub-device list without intervention of 
the host.

 Publishing of at least one command on the wireless device level enables detection of 
configuration changes and automatic device cache invalidation without intervention of the 
host.

 Publishing of at least one command also ensures that the cached status information is 
updated for cached configuration commands.

 Short publishing intervals may impair battery life of wireless devices.

Figure 5.14 Diagnostics > Wireless Communication > Burst Lists

Note!
The WirelessHART gateway is able to cache up-to-date device status information only if at 
least one command is published in each wireless device. Up-to-date data is important for 
efficient device status monitoring. You can find the publishing parameters of most 
WirelessHART devices in the Burst Mode menu of the DTM.
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To show/hide the index number of a device in the structure, deactivate/activate Tree-View. If 
Tree-View is deactivated, the devices are shown in the order they were added to the 
instrument list.

If required, click Refresh to reload the burst parameters of all devices.

General Data

Caution!
System failure

If you click Refresh right after the device was switched on or reset, the system may stop 
responding.

If the device was switched on or reset, wait about 1 minute until the boot process is complete 
before you click Refresh.

Note!
If using the DTM and PACTware to configure the WirelessHART gateway, the following data is 
available only during online parameterization.

Displayed 
Information Description
Long Tag Displays the long tag of the device.

HART 5 devices and older devices do not support long tags. For those 
devices, the WirelessHART adapter uses the content of the Message field 
which will be displayed here instead.

I/O Card Indicates the virtual I/O card number to which the device is mapped to. See 
chapter 2.1.3

Channel Indicates the channel of the virtual I/O card that the device is mapped to. See 
chapter 2.1.3
The value 0 identifies a WirelessHART device or a WirelessHART adapter, 
while the value 1 identifies a wired device connected to a WirelessHART 
adapter.

Device Type Displays the device type as registered at the HCF.
Status The following communication statuses exist:

communication not possible
communication possible, device not identified
(flashing) communication possible, identification ongoing

device connected and identified
Dev. Status Note that the device status displayed in the list may differ from the actual 

device status because the HART status bits may be interpreted differently.
The following device statuses exist:

maintenance required
out of specification
check function

failure
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Burst Parameters

Topology View
The topology view is a graphical overview of all wireless devices within your network, including 
their connection status and connection paths. To set up the topology view, go to Engineering 
> Topology View. See chapter 5.5.4

The lines between the devices represent the connection paths. The thickness of a connection 
path indicates the traffic for this path compared to the total traffic. The color of the connection 
path indicates the stability of the connection for this path.

The topology view also displays the path statistic. Move the mouse over a path in order to 
display an information box with the following details:

 Stability
 Radio signal strength intensity (RSSI)

Move the mouse over a field device in order to display an information box with the following 
details:

 Reliability
 Latency

Traffic

Parameter Description
+ To show/hide the list of burst messages for a device, click the + sign in the + 

column.
Burst 
Command

Displays the HART command number and its description.

Num. 
Packets

Number of burst messages the device has sent.

Table 5.9 Burst Parameters

Note!
Traffic and stability data is available only after a statistics cycle of 15 minutes has been 
completed.
Note that the data that is displayed in the topology view represents a single cycle of 15 minutes 
only.

Line Style Description
Dotted lines represent unused paths.
Thin lines represent paths with poor traffic (compared to the total 
traffic).
Medium lines represent paths with medium traffic (compared to the 
total traffic).
Thick lines represent important connection paths with heavy traffic 
(compared to the total traffic).
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Stability
Color Successfully received messages in %

0 - 10

10 - 20

20 - 30

30 - 40

40 - 50

50 - 60

60 - 70

70 - 80

80 - 90

90 - 100

Note!
For paths indicated in black, there is no statistic information available.

Example!
In the following example you can see that the devices WHA-ADP-CorrTran and 
Test_Dev_598 have no network connection (red status icon and no connection paths) and 
thus they are unavailable. Apart from these devices, all other devices are linked with unused 
connections (dotted lines), which means that if the main connection fails, the communication 
can easily be switched to an alternative, unused connection path.
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Figure 5.15 Diagnostics > Wireless Communication > Topology View

Use the slider to zoom in or out of the topology view. To reset the zoom to its default value, 
click Reset Zoom.

Click the devices in the topology view for more information on the device.

If required, click Refresh to reload the device information and rebuild the topology view. Note 
that rebuilding the topology view takes some time.

Topology View Parameters

Display connection paths for a single device
1. Select Selected in the Paths shown drop-down list.
2. Move the cursor over a device in the topology view.

 The connection paths are displayed for the select device.

Caution!
System failure

If you click Refresh right after the device was switched on or reset, the system may stop 
responding.

If the device was switched on or reset, wait about 1 minute until the boot process is complete 
before you click Refresh.

Parameter Description
Horizontal 
image origin

Displays the horizontal respectively vertical alignment of the background 
image. See chapter 5.5.4

Vertical 
image origin
Resolution Displays the resolution of the background image. See chapter 5.5.4
Paths shown Enables you to select the connection paths that are displayed in the topology 

view.
Table 5.10 Topology View Parameters
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5.4.3 Wired Communication
The overview screen provides information the host connection of the WirelessHART gateway. 
The information is only available when online.

Figure 5.16 Diagnostics > Wired Communication > Overview

Overview Information
Displayed Information Description
Messages received through HOST Total bytes received by the host system.
Messages returned to HOST Total bytes transmitted to the host system.
Number of Requests forwarded to the I/O 
system
Number of responses returned from the I/O 
system
Table 5.11 Overview Information
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Figure 5.17 Diagnostics > Wired Communication > HART

Note!
Not all parameters from the Diagnostics > Wired Communication > HART window are used 
by the WirelessHART gateway. In the following table, only the relevant parameters are 
described.
Most parameters are transient parameters, which means that they are automatically reset if the 
status does no longer apply. The following exceptions have to be reset by pressing Reset 
Diagnostic Bits in the Additional Functions > Reset menu.

 Active Device List changed
 More Status Available
 Configuration Changed
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HART Parameters
Parameter Description

Extended Device Malfunction
Manager fault Non-recoverable hardware fault within the manager section of the 

WirelessHART gateway.
Non-Volatile 
Memory 
Defect

Non-recoverable hardware fault within a non-volatile memory area.

Volatile 
Memory 
Defect

Non-recoverable hardware fault within a volatile memory area.

Ethernet 
Communicatio
n Fault

Non-recoverable hardware fault within the communication controller 
associated with the Ethernet interface.

Electronic 
Defect

Non-recoverable hardware fault within the WirelessHART gateway different 
from the other faults in the "Extended Device Malfunction" category.

RS-485 
Communicatio
n Fault

Non-recoverable hardware fault within the communication controller 
associated with the RS-485 interface.

Gateway Operation in Progress
Block transfer When the checkbox is activated, this shows that block-transfer activity is 

going on in the WirelessHART gateway.
Delayed 
answer

When the checkbox is activated, this shows that delayed-answer activity is 
going on in the WirelessHART gateway, which can be related either to a 
buffer of the WirelessHART gateway or to a buffer of a connected device.

Self-test This bit is associated with a self-test activity triggered by CMD 41. The 
checkbox remains activated until the activity has been completed.

File update If required, the WirelessHART gateway can write persistent (i.e. non-volatile) 
information to its local file system. The checkbox remains activated as long as 
information is being written to the file system.

Start-up phase At each power-up or software restart / reset (triggered by CMD 42 & 141), the 
WirelessHART gateway polls all devices within the Instrument List to check 
their communication statuses and to update their identity information. The 
checkbox remains activated until the start-up phase has been completed.

Extended List Changes
Instrument List 
changed

This checkbox is activated whenever the Instrument List content is changing.

Active Device 
List changed

This checkbox is activated whenever the "Active Device list" content is 
changing. This is the case when a "communication loss" or a "communication 
recovered" event takes place for a device.

Cumulative Device Status
These bits are set to 1 whenever the related status applies to one or more devices (or sub-
devices) connected to the WirelessHART gateway.
Primary 
Variable out of 
Limits

The PV is beyond its operating limits.

Non-Primary 
Variable out of 
Limits

A device variable not mapped to the PV is beyond its operating limits.

Loop Current 
Saturated

The loop current has reached its upper (or lower) endpoint limit and cannot 
increase (or decrease) any further.
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Loop Current 
Fixed

The loop current is being held at a fixed value and is not responding to 
process variations.

More status 
available

More status information is available via Command 48 (Read Additional Status 
Information).

Cold Start A power failure or device reset has occurred.
Configuration 
Changed

An operation was performed that changed the device's configuration. 

Device 
Malfunction

The device detected a serious error or failure that compromises device 
operation.

Cumulative Extended Device Status
These bits are set to 1 whenever the related status applies to one or more devices (or sub-
devices) connected to the WirelessHART gateway.
Maintenance 
Required

One or more wireless devices require maintenance.

Device 
Variable Alert

One or more wireless devices have a device variable alert. This bit is set if any 
device variable is in alarm or warning state.

Critical Power 
Failure

One or more wireless devices have a power failure (e.g. battery low).

Device Operation in Progress
These bits are set to 1 whenever the related procedure is ongoing in one or more devices (or 
sub-devices) connected to the WirelessHART gateway. When an operation is ongoing, the 
WirelessHART gateway will return a "Busy" response code to any HART message of the host 
directed to the relevant device (or sub-device). These bits are not latched and simply reflect 
the current operation status.
"Configuration 
Changed bit 
reset" 
procedure

The "Configuration Changed bit" procedure is being performed at one or 
more devices.

"Sub-Device 
update" 
procedure

One or more sub-devices of WirelessHART adapters are being updated.

"Device 
update" 
procedure

One or more wireless devices are being updated.

Table 5.12 HART Parameters

Parameter Description
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5.5 Engineering
The Engineering section consists of the following sections:

 Instrument List
You can freely define an instrument list of all network devices before the devices actually 
join the network. Hereby you can make sure that a device is associated with the 
predefined I/O card number when the network is reformed or the WirelessHART Gateway 
is reset.

 Topology View
You can upload a background image and arrange the WirelessHART devices in the 
image to set up the topology view.
Note that the instrument list must be available before you set up the topology view, 
because the set of WirelessHART devices is derived from the instrument list.

Figure 5.18 Relationship between the configuration options in the DTM or web interface and the 
data in the WirelessHART Gateway

1. The Instrument List you set up via the DTM or the web interface is not necessarily iden-
tical to the Operating Modes list of the WirelessHART Gateway.
You can set up the Instrument List manually, import an existing list from a CSV file, import 
the devices from the PACTware® project tree, or import the devices from the Operating 
Modes list of the WirelessHART Gateway. You can freely edit the Instrument List in the 
DTM or web interface. Once the list of devices and their IO card and channel association 
is complete, you can write this information back to the Operating Modes list of the Wire-
lessHART Gateway.
The Operating Modes list contains all devices of the WirelessHART network and is con-
stantly updated.
If a new device joins the network, it is automatically inserted into the Operating Modes 
list. If the long tag or address of the new device matches an entry from the list, for example, 
an entry that you predefined using the Instrument List, the device is associated with the 
predefined values. If not, it is automatically associated with the next free IO card number 
and it will not appear in the Instrument List unless you import the device list from the Op-
erating Modes list.

WirelessHART Network

DTM or
Web Interface

Operating Modes Instrument List

Topology View Topology View

CSV file
PACTware®

project tree

WirelessHART
Gateway

number
of devices

device positions, and
background image

import device list
with IO-card and
channel position import devices

new devices are
added automatically

import device list,
positions, and

background image import devices

import devices

1

2
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2. In the DTM or web interface you can upload a background image and arrange the positions 
for all devices of the Instrument List. After you set up the topology view, you can write the 
information back to the WirelessHART Gateway.
If a new WirelessHART device joins the WirelessHART network, it is inserted at a default 
position by the WirelessHART Gateway. To rearrange new devices in the DTM or web in-
terface, you can import the new device into the Instrument List or import the device list 
from the WirelessHART Gateway.

5.5.1 Instrument List
The instrument list is a copy of the Operating Modes list, which is currently active in the 
WirelessHART gateway and represents the virtual I/O system of the WirelessHART gateway. 
See chapter 2.1.3
Thus, unless the Instrument List is reloaded from the WirelessHART gateway, it may not 
necessarily be identical to the Operating Modes list that is currently active in the 
WirelessHART gateway.

By creating an instrument list before the devices actually join the network, you can make sure 
that a device is associated with a predefined I/O card number when the network is reformed or 
the WirelessHART gateway is reset. Note that the instrument list is used for editing the devices 
and that the cached values of the devices are located under Measurement. 

For a detailed overview of the relationship between the configuration options in the DTM or 
web interface and the data in the WirelessHART Gateway, see chapter 5.5.

Figure 5.19 Engineering > Instrument List

Note!
This list is stored in a non-volatile memory of the WirelessHART gateway. The card and 
channel number assignment will remain the same after a restart of the WirelessHART gateway 
or software.
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Instrument List

Editing the Instrument List

1. To read the Operating Modes list from the WirelessHART gateway using the web interface, 
click Refresh. If using the DTM to configure the WirelessHART gateway, select the Wire-
lessHART gateway in the project tree and choose Device > Load from device. If using the 
DTM to configure the WirelessHART gateway, you can also import the devices of the project 
tree by clicking Import Project Tree (DTM).

2. To add a device, click into the last row of the instrument list and specify the device 
parameters. Press Enter to confirm your entries.
You can also edit existing entries by clicking into the corresponding cells of the instrument 
list.

3. To remove a device from the instrument list, click the X-sign at the end of the row. The 
respective I/O card becomes vacant again.

4. To write the current instrument list to the WirelessHART gateway using the web interface, 
click Apply. If using the DTM to configure the WirelessHART gateway, select the 
WirelessHART gateway in the project tree and choose Device > Store to device.
Note that the consistency of the instrument list is not checked before it is applied.

To export the current instrument list to a CSV file, click Export (web interface) resp. Export 
CSV (DTM).

Displayed 
Information Description
Long Tag Long tag of the device

HART 5 devices and older devices do not support long tags. For those 
devices, the WirelessHART adapter uses the content of the Message field, 
which will be displayed here instead.

I/O-Card Virtual I/O card number to which the device is mapped to. See chapter 2.1.3
Channel Channel of the virtual I/O card the device is mapped to.

The value 0 identifies a WirelessHART device or a WirelessHART adapter, 
while the value 1 identifies a wired device connected to a WirelessHART 
adapter.

Device ID HART serial number that is assigned at manufacturing time and that differs for 
each HART device of a given type. The Device ID is used to build the HART 
long frame address.

Ext. Device 
Code

Extended device type code of the device
Identifies the HART product family. Each product family is identified by a 
unique code.

Table 5.13 Instrument List

Caution!
System failure

If you click Refresh right after the device was switched on or reset, the system may stop 
responding.

If the device was switched on or reset, wait about 1 minute until the boot process is complete 
before you click Refresh.

Note!
When editing the instrument list, incomplete entries are highlighted in red. These errors must 
be corrected before you can apply the instrument list.
Warnings are highlighted in yellow.
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To load the instrument list from a CSV file, click Import (web interface) resp. Import CSV 
(DTM).

For more information on the structure of the CSV file, see chapter 12.

5.5.2 Security: Access Control List, Temporary Join Key

Whitelist for Access Control
The  WirelessHART gateway supports the "whitelist" security mode. The whitelist is an 
additional security feature to ensure that only authorized personnel can add a new device. For 
example if an external company sets up the network by using this feature, this can help to 
ensure that no further changes in consequence of the setup take place. 

New WirelessHART devices can only be added to the network provided that their addresses 
are listed in the whitelist and can be identified. 

If needed, you can manipulate the join key as follows: 

 Change the join key permanently for all devices connected to the network. For more 
information on the join key, .

 Define a temporary join key that is automatically invalidated after a defined period of time. 
This can be used for temporary devices needed for maintenance reasons.

You can monitor the process of this change until the join key has been successfully 
manipulated as required.

Defining or Changing a Whitelist
1. Go to Engineering > Security.
2. In order to copy the network to the whitelist, click on Transfer Network to Whitelist-

 A confirmation request dialog opens: The whitelist will be changed. The current whitelist 
is flushed and cannot be recovered.

3. Confirm with Yes.
 The new devices in the whitelist table are check marked. The whitelist is changed: The 

specified devices in the device list below receive a "Whitelisted" check mark (1).
The whitelist is generated.

Note!
If a WirelessHART Gateway is replaced with a new one, we recommend that you use the 
export/import functionality to transfer the settings from the old WirelessHART Gateway to the 
new one. Otherwise, the new WirelessHART Gateway rebuilds the WirelessHART network 
from scratch by default, which means that the virtual HART I/O structure in the instrument list 
will differ from the structure that has been defined in the old WirelessHART Gateway.
Furthermore, if using the DTM to configure the WirelessHART Gateway, you can prepare the 
instrument list offline and export the configuration into a CSV file. Once the WirelessHART 
Gateway is available on site, you can import the prepared configuration via the CSV file.

1
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4. Next, set the Network Access Mode pull-down menu from Open to Whitelist and confirm 
with OK.

 Now, only the listed devices that are check-marked as whitelisted can join and re-join 
the network. 
Any attempts to enter the network, even with a valid network ID and join key, in order to add 
an unauthorized device will be rejected. 
The network is logged.

Assigning a Temporary Join Key to Add Devices
A temporary join key can be useful for adding devices e. g. from subcontractors for 
maintenance purposes within limited periods. This way, you do not need to reveal the regular 
join key of your network.

1. In order to open your network: In the Network Access Mode pull-down menu, select Open.
2. Enter the temporary join key. Use the Temporary Join Key Part 1 ... 4 (HEX) fields.
3. Select a Temporary Join Mode Time from the pull-down menu.

 During this time, other devices are entitled to join the network. The whitelist preview 
grows dynamically as the devices are added to the list.

4. Start the temporary join mode. Use the double arrow buttons to Start Temporary Join 
Mode.

5. Copy devices to the whitelist and close the network again. See section "Defining or 
Changing a Whitelist" above.

5.5.3 Stale Value Detection (Early Warning)
The web interface offers the configuration of notification limits in case the value of a cached 
dynamic variable or the command 48 status information of a wireless device is going stale. 
This way, you are informed promptly in case the variable or information is not updated at the 
expected rate, i. e., at the burst rate of the field device. 

The WirelessHART gateway reads the expected burst rates from each field device and "time-
stamps" each burst message at the time of receipt. This way, the age of each cached value 
can be calculated as a percentage value of the existing burst rate.

From this information, the WirelessHART gateway can determine whether a message is 
overdue or not: The gateway starts to count the age of the last sent value until the gateway 
receives the next value from the field device and then starts to count again, and so on.

Example
You can define a warning and an error limit, e. g., 150 % and 300 % of the age threshold value. 
A burst alarm is generated if these defined values are exceeded. In the Measurement List of 
the web interface, you can check the age of the age threshold value. In this menu, the gateway 
indicates the age threshold value in percent in the colors green (on time), yellow (overdue), 
and red (error).

 Good value: Value is no older than 150 % of the burst rate. The value is indicated in 
green.

 Age Threshold Warning: Value has exceeded 150 % of the burst rate in this example. 
The value is indicated in yellow.
The warning limit is typically used to identify temporary communication problems.

Tip
Provided that the field devices have reasonable burst rates, the specification of age threshold 
limits enable you to detect communication loss very early. 
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 Age Threshold Error: Value has exceeded 300 % of the burst rate in this example. The 
value is indicated in red.
The age threshold error limit is typically used to indicate a - likely - complete loss of the 
device, e. g., due to a battery removal. In case of an error condition, it is possible to set 
additional individual substitution values for each variable for application-related failure 
handling. For more information, .

Viewing the Age Threshold Value Status
In the WirelessHART gateway web interface, go to Engineering > Measurement List.

Figure 5.20 Engineering > Measurement List, viewing the age threshold value limits 

5.5.4 Topology View
Here you can set up the topology view that is displayed under Diagnostics > Wireless 
Communication > Topology View. You can upload background images in any common 
graphic format, such as JPG or GIF. For example, you can use a satellite photo, a floor plan, or 
a diagram in which you want to group the devices

For a detailed overview of the relationship between the configuration options in the DTM or 
web interface and the data in the WirelessHART gateway, .

Figure 5.21 Engineering > Topology View

Note!
The Instrument List must be available before you set up the topology view, because the set of 
WirelessHART devices is derived from the Instrument List. 
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Set Up the Topology View
1. To retrieve the devices from the Operating Modes list of the WirelessHART gateway using 

the web interface, click Refresh. If using the DTM to configure the WirelessHART gateway, 
select the WirelessHART gateway in the project tree and choose Device > Load from de-
vice. Note that reloading the device information takes some time.

2. Click Select Map to select a background image for the topology view.
3. Click Browse to select the background image.
4. Click Upload Map to upload the background image.
5. If required, edit the coordinates of the image origin in the Horizontal image origin and 

Vertical image origin boxes.
6. Enter a value in the Resolution box to scale the background image, for example 1 m/pixel. 

Note that you can set the resolution only after you have uploaded an image.
7. Arrange the WirelessHART devices in the topology view by dragging and dropping the 

devices to a selected position. Note that for a more accurate positioning you can use the 
slider to zoom in or out of the topology view. To reset the zoom to its default value, click 
Reset Zoom.

8. To write the current topology view to the WirelessHART gateway using the web interface, 
click Apply. If using the DTM to configure the WirelessHART gateway, select the 
WirelessHART gateway in the project tree and choose Device > Store to device.

To export the current devices and their positions to a CSV file, click Export (web interface) 
resp. Export CSV (DTM).

To load a list of devices and their positions from a CSV file, click Import (web interface) resp. 
Import CSV (DTM).

For more information on the structure of the CSV file, see chapter 12.

Caution!
System failure

If you click Refresh right after the device was switched on or reset, the system may stop 
responding.

If the device was switched on or reset, wait about 1 minute until the boot process is complete 
before you click Refresh.

Note!
Required Display Resolution for the Topology View
In order to guarantee a fully visible, undistorted, and uncropped background image, we 
recommend to set the display resolution to a 4:3 proportion within the following pixel resolution 
range:
800 x 600 ... 1600 x 1200
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5.6 Additional Functions
Accessing the Additional Functions Window
1. If using the DTM and PACTware, right-click the device in the project tree, select Additional 

functions and choose the desired function.
2. If using the web interface, select Additional Functions in the navigation area on the left.

5.6.1 Print Engineering Menu
In the DTM, all the settings of the WirelessHART gateway Engineering menu can be printed 
out. This provides a quick and easy way to get a printout of the instrument list or the network 
properties, etc.

Printing the Engineering Menu
In the DTM select Device > Print

5.6.2 Set DTM Address
The table in the Set DTM address window shows the WirelessHART devices configured in 
the PACTware project and their DTM addresses. The DTM address is the device long tag as 
specified in the DTM of the device (offline data record). The DTM address is also displayed in 
the project tree structure of the PACTware project.

Figure 5.22 Additional Functions > Set DTM address

Changing the DTM address
1. Place the cursor inside a cell of the Long Tag column.
2. Change the device long tag as required. You may change the long tags of several devices 

at once, if needed.
3. Close the DTM dialogs of the devices whose long tags are to be changed.
4. To apply the new DTM address(es) press Update changed tags.

 The new DTM addresses are displayed in the project view of PACTware.

Note!
The Long Tag parameterized in the Set DTM Address window must be identical with the 
Long Tag of the same device parameterized in the Set device address window. See chapter 
5.6.3
Otherwise the DTM is not able to establish a connection to the device.
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5.6.3 Set Device Address
The table in the Set device address window shows the WirelessHART devices in the 
network. The device address is the device long tag stored in the device.

Figure 5.23 Additional Functions > Set device address

Changing the device address
1. Place the cursor inside a cell of the Long Tag column.
2. Change the device long tag as required. You may change the long tags of several devices 

at once, if needed.
3. To apply the new DTM address(es) press Update changed tags.

 The new DTM addresses are stored to the devices.

Note!
Additional functions > Set device address is available only online, while the connection to 
the WirelessHART gateway and the WirelessHART device(s) is active.

Note!
The Long Tag parameterized in the Set Device Address window must be identical with the 
Long Tag of the same device parameterized in the Set DTM address window. See chapter 
5.6.2
Otherwise the DTM is not able to establish a connection to the device.
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5.6.4 Device Reset

Figure 5.24 Additional Functions > Device Reset

Reset Options

5.6.5 Self Test
After pressing the Perform Self-Test button in the Additional Functions > Self Test menu 
the device carries out a self test.

The results of the self test can be seen in the Diagnostics menu. See chapter 5.4

5.6.6 About
Additional Functions > About displays information about the device, its manufacturer, and 
its firmware version.

Parameter Description
Device Reset Restarts the software of the WirelessHART gateway without any impact on 

the established network (which is not reformed).
This function does not set the parameters of the WirelessHART gateway back 
to their default values. It restarts the WirelessHART gateway software only.

Rebuild 
Instrument 
List

Regenerates the instrument list from scratch.
The existing instrument list is overwritten. Note that the MODBUS addresses 
of the devices in the network will be changed by resetting the instrument list.
We recommend that you create a backup of the current instrument list before 
rebuilding a new instrument list. 

Reform 
Network

Restarts and re-establishes the network. For example, this function is needed 
to activate a new network ID. 
Depending on the size of the network, this process may take several minutes.
This function does not set the parameters of the WirelessHART gateway back 
to their default values. It restarts the network only.

Reset 
Diagnostic 
Bits

Resets the HART parameters under Diagnostics > Wired Communication 
> HART to its default values.

Table 5.14 Reset Options
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5.6.7 Firmware Upgrade

Figure 5.25 Additional Functions > Firmware upgrade

Upgrading the Firmware
1. Choose Additional Functions > Firmware Upgrade.
2. Click Browse to choose the firmware upgrade package (*.ipk) from your hard drive.
3. Click Upload the Package.
4. To install the firmware upgrade, press Install the Package. You can also abort the 

upgrade process by clicking Discard Upgrade.
 The installation process may take a while. When the installation is finished, Installation 

Successfully Completed is displayed.
5.6.8 Change Password

Figure 5.26 Changing Password

Note!
This configuration option is only available in the web interface.

Note!
This configuration option is only available in the web interface.

1

2

3

4
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The connection to the web interface is made using a secure connection (HTTPS) which 
requires a user name and a password. The factory default settings are:
User name: admin
Password: admin

You can change both user name and password in the web interface.

Changing the Password
1. Log on to the web interface of the WirelessHART gateway using the user name for which you 

want to change the password.
2. Choose Additional Functions > User Level (1).
3. Enter the old password into the corresponding fields (2).
4. Enter a new password into the corresponding fields and repeat your input (3).
5. To apply the new password, click Change Password (4).

 The password for the current user has been changed.

Figure 5.27 Changing User Level

Changing User Level
1. Choose Additional Functions > User Level (1).
2. To change the user level, click on the buttonChange User Level (2).

 The "Login Page" opens.
3. Select your user level (3). You can choos between "Administrator" and "Operator" level.

1

3

2
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5.6.9 Upload Certificate for HTTPS Connection
You can install a trusted certificate issued by a certification authority, such as TC TrustCenter, 
Thawte, or VeriSign.

A digital certificate is an electronic document that binds a public key with an identity, for 
example, an organization or an user. The binding between a public key and the identity is done 
by a signature. This signature can be self-signed or authenticated by a certification authority. 
The WirelessHART gateway is delivered with a self-signed certificate for the HTTPS 
connection. Because the web browser cannot verify the authenticity of a self-signed certificate, 
some web browsers display the following (or a similar) warning message in the address bar:

Figure 5.28 Additional Functions > Upload Certificate

Install a Trusted Certificate

1. Click Browse and select the certificate file from the certification authority.
2. Click >> to upload the certificate.

 The Upload Private Key option appears.
3. Click Browse and select the private key from the certification authority.
4. Click >> to upload the private key.

 The Change Certificate and Private Key option appears.
5. Click >> to install the certificate and private key.

Note!
This configuration option is only available in the web interface.

Note!
Prerequisites:

 You need a certificate and a private key from a trusted authority, such as TC TrustCenter, 
Thawte, or VeriSign.

 Both files must comply with the following standard: X.509 Ver. 3
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Figure 5.29 Installation confirmation

6. Go to Additional Functions > Device Reset and perform a device reset for the changes 
to take effect.

If the trusted certificate has been installed successfully, the address bar in the web browser 
displays a padlock icon:

This indicates that the web interface of the WirelessHART gateway is a trusted site.

5.6.10 Auto Refresh
All the parameter values of the  WirelessHART gateway web interface and DTM are 
automatically refreshed at a default interval of 60 s.

Figure 5.30 Additional Functions > Auto Refresh

Adjusting or Deactivating Auto Refresh
Select Auto refresh and choose a setting between 10 s ... 60 min. 
Alternatively deselect Auto refresh altogether if required.



 2
01

9-
06

82

WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Configuration via Web Interface

5.7 Measurement
The measurement list displays a comprehensive overview of all cached parameters and 
values of all sub devices.

Figure 5.31 Measurement List

If required, click Refresh to reload the values of all sub devices.

Note!
This list is stored in a non-volatile memory of the WirelessHART gateway. The card and 
channel number assignment will remain the same after a restart of the WirelessHART gateway 
or software.

Note!
Please keep in mind that the dynamic values of each sub device (analogue value, PV, SV, TV, 
QV) are cached by the WirelessHART gateway only if the respective sub device publishes 
those values. See chapter 2.1.4
After a network restart, the Operating Modes list needs time to rebuild. During this time, some 
information is set to 0 or replaced by wildcard characters.

Caution!
System failure

If you click Refresh right after the device was switched on or reset, the system may stop 
responding.

If the device was switched on or reset, wait about 1 minute until the boot process is complete 
before you click Refresh.

Note!
If using the DTM and PACTware to configure the WirelessHART gateway, the following data is 
available only during online parameterization.
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General Data

Measured Values

Age
The WirelessHART gateway reads the expected burst rates from each field device and 
"timestamps" each burst message at the time of receipt. This way, the age of each cached 
value can be calculated as a percentage value of the existing burst rate.

From this information, the WirelessHART gateway can determine whether a message is 
overdue or not: The gateway starts to count the age of the last sent value until the gateway 
receives the next value from the field device and then starts to count again, and so on.

Displayed 
Information Description
Long Tag Displays the long tag of the device.

HART 5 devices and older devices do not support long tags. For those 
devices, the WirelessHART adapter uses the content of the Message field 
which will be displayed here instead.

I/O Card Indicates the virtual I/O card number to which the device is mapped to. See 
chapter 2.1.3

Channel Indicates the channel of the virtual I/O card that the device is mapped to. See 
chapter 2.1.3
The value 0 identifies a WirelessHART device or a WirelessHART adapter, 
while the value 1 identifies a wired device connected to a WirelessHART 
adapter.

Device Type Displays the device type as registered at the HCF.
Status The following communication statuses exist:

communication not possible
communication possible, device not identified
(flashing) communication possible, identification ongoing

device connected and identified
Dev. Status Note that the device status displayed in the list may differ from the actual 

device status because the HART status bits may be interpreted differently.
The following device statuses exist:

maintenance required
out of specification
check function

failure

Displayed 
information Description
Loop Current Analogue value of the primary variable
PV Value of the primary variable
SV Value of the secondary variable
TV Value of the tertiary variable
QV Value of the quaternary variable
Table 5.15 Measured Values
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You can define a warning and an error limit, e. g., 150 % and 300 % of the age threshold value. 
A burst alarm is generated if these defined values are exceeded. In the Measurement List of 
the web interface, you can check the age of the age threshold value. In this menu, the gateway 
indicates the age threshold value in percent in the colors green (on time), yellow (overdue), 
and red (error).

5.8 EtherNet/IP Configuration
The WirelessHART Gateway acts as an EtherNet/IP adapter and makes the data of HART 
devices available via EtherNet/IP. To do so, the WirelessHART Gateway can establish up to 
10 cyclic data transfer connections with 4 HART devices per connection. Thus, the 
WirelessHART Gateway provides the data of a maximum number of 40 HART devices via 
cyclic connections. In addition to the cyclic connections, the WirelessHART Gateway can 
establish direct data transfer connections via HART tunneling for special tasks.

Steps to Setup the EtherNet/IP Connection
1. Setup the WirelessHART network. Use a cable connection to define the Network ID and 

Join Key for all WirelessHART devices.
See chapter 5.2

2. Define the HART descriptors for all HART devices (field devices and WirelessHART 
devices) that shall be monitored via EtherNet/IP according to the dedicated naming 
convention.
See chapter 5.8.1

3. Define the burst commands for all HART devices (field devices and WirelessHART 
devices) that shall be monitored via cyclic EtherNet/IP connections.
See chapter 5.8.2

4. Integrate the WirelessHART Gateway in your control system by installing the Add-On 
Profile (AOP) or EDS file.
See chapter 5.8.3

5. Setup the cyclic or direct data transfer with the HART devices.
See chapter 5.8.4
See chapter 5.8.7

5.8.1 Naming Convention for HART Descriptors
The data assignment in the EtherNet/IP protocol is performed via the HART descriptor. 
Therefore, all HART devices (field devices and WirelessHART devices) that shall be available 
via EtherNet/IP must follow a dedicated naming convention for the HART descriptor. If you 
want to access the data of a WirelessHART Adapter itself, for example, if you want to read its 
battery status, the HART descriptor of the WirelessHART Adapter must follow the same 
naming convention.

The naming convention for the HART descriptor applies for the cyclic and direct data transfer 
connections.

Use the DTM of the corresponding HART devices to define its HART descriptors.



WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Configuration via Web Interface

 2
01

9-
06

85

HART Descriptor Naming Convention

The WirelessHART Gateway automatically occupies the first identifier @A0 regardless of the 
HART descriptor that has been defined.

Maximum length for HART descriptors: 16 characters
You can freely choose 
the first 13 characters.

The last 3 characters of the HART descriptor must contain a unique 
identifier that is used to assign a HART device with an EtherNet/IP 
connection.
@
Each identifier starts 
with an @ sign.

A ... J for cyclic 
connections

0 ... 3

Each letter designates one cyclic connection 
and each number designates a HART device. 
Because the WirelessHART Gateway can 
establish up to 10 cyclic connections with 4 
HART devices per connection, the 
namespace for cyclic connections starts with 
A0 and ends with J3.
A ... Z for direct 
connections

0 ... 3

In addition to the cyclic connections, the 
WirelessHART Gateway can establish direct 
connections to a multitude of HART devices. 
The naming convention of the cyclic 
connection applies to direct connections as 
well, except that the number is not limited. 
Therefore the namespace for direct 
connections starts with A0 and ends with Z3. 
Note that the devices between K0 and Z3 can 
only be accessed via direct connections.

Example!
If a WirelessHART network consists of a WirelessHART Gateway, 4 HART field devices, and 4 
WirelessHART Adapters that shall be monitored via EtherNet/IP as well, the HART descriptors 
can look as follows.

 HART field devices:
DESC01@A1
DESC02@A2
DESC03@A3
DESC04@B0

 WirelessHART Adapters:
DESC05@B1
DESC06@B2
DESC07@B3
DESC08@C0

Because the WirelessHART Gateway automatically occupies the @A0 identifier, the remaining 
identifiers for the first cyclic connection are @A1, @A2, and @A3. The remaining devices must 
be assigned to new cyclic connections because each connection can incorporate a maximum 
number of 4 devices. The resulting identifiers are @B0, @B1, @B2, @B3, and @C0.

Tip
If you got a large number of HART field devices, you can use the identifiers from @A1 to @J3 for 
the HART field devices and you can use the identifiers from @K0 to @Z3 for the WirelessHART 
Adapters. This way, you can monitor the data of the HART field devices via cyclic connections 
and monitor the battery status of the WirelessHART Adapters only once a day via direct 
connections.
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5.8.2 Burst Commands for Cyclic Data Transfer
All variables can be divided into two groups: static variables that do not change often, such as 
configuration data, and dynamic variables that may change often, such as process data. Static 
variables are automatically polled by the WirelessHART Gateway whereas dynamic variables 
are not automatically polled. As a result, all dynamic variables required for cyclic data transfer 
must be bursted by the HART devices.

Use the DTM of the corresponding WirelessHART devices to make them burst the following 
HART commands:

 Command 9 (Read Device Variables with Status)
 Command 48 (Read Additional Status)

As an alternative to command 9 you can also burst command 3 (Read All Dynamic Variables 
and Loop Current) or command 33 (Read Device Variables)

Variables Provided by these HART Commands

To make the complete cyclic data valid, Commands 9 and 48 have to be bursted. As 
alternative to Command 9, the command 3 (Read All Dynamic Variables and Loop Current) or 
33 (Read Device Variables) can be bursted.

The .NoDataBurstConfigured bit contained in DeviceStatus_Struct indicates that none of the 
Commands 3, 9 or 33 is bursted. The .NoCmd48BurstConfigured bit contained in 
DeviceStatus_Struct indicates that Command 48 is not bursted. Variables that are not 
retrieved through burst messages are set to the invalid. See table "Data Block of the 
WirelessHART Gateway" on page 93 see table "Data Block of HART Devices" on page 94

Tip
We recommend that you assign the HART descriptors in sequence, without leaving gaps in 
between. For example, if the HART descriptors for 3 HART devices are set to @A1, @A2, and 
@J0, all 10 cyclic connections must be established to access the HART device @J0, which 
causes unnecessary network traffic.

Note!
According to the HART specifications for WirelessHART devices, the burst configuration of 
wired devices has to be set up using the bridge device (WirelessHART Adapter) that connects 
the wired devices to the WirelessHART network. Burst commands that are set up directly on 
the wired device are not recognized and cause the .NoCmd48BurstConfigured bit and the 
.NoDataBurstCommandConfigured bit to be set. See chapter 5.8.6

Cyclic Data Variable
Contained in HART Command
3 9 33 48

PV, SV, TV, QV x x x
PV Status, SV Status, TV Status, QV Status x
PV Unit, SV Unit, TV Unit, QV Unit x x x
Additional Device Status Information x

Tip
You can review the burst commands of all HART devices in the WirelessHART network under 
Diagnostics > Wireless Communication > Burst Lists. See chapter 5.4.2



WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Configuration via Web Interface

 2
01

9-
06

87

5.8.3 Integration in PLC via EtherNet/IP

Rockwell Automation ControlLogix® Control System
Integration of the WirelessHART Gateway in the Logix Controller is performed via an Add-On 
Profile (AOP).

You can access all software and documentation on the WirelessHART Gateway at 
http://www.pepperl-fuchs.com.

After installation of the Add-On Profile the WirelessHART Gateway is accessible via the device 
catalog of the Logix Controller.

Other Control Systems
You can also integrate the WirelessHART Gateway into a different control system by using an 
Electronic Data Sheet (EDS). The EDS file is used by network configuration tools to help you to 
identify and commission a product on a network.

You can access all software and information on the WirelessHART Gateway at 
http://www.pepperl-fuchs.com.

For more information on how to install an EDS file and integrate a new device, see the 
corresponding documentation of your control system vendor.

5.8.4 Cyclic Data Transfer in Logix Controller
Configure IP Address of the WirelessHART Gateway
1. Double-click the WirelessHART Gateway in the Controller Organizer window of the Logix 

controller.

Figure 5.32 Controller Organizer

 The Add-On Profile of the WirelessHART Gateway opens.

http://www.pepperl-fuchs.com
http://www.pepperl-fuchs.com
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Figure 5.33 Module Properties window

2. Enter the IP address of the WirelessHART Gateway in the Ethernet Address area on the 
General tab.

Configure Maximum Number of HART Devices
1. Select the General tab of the Add-On Profile of the WirelessHART Gateway.
2. Click Change in the Module Definition area on the General tab.

 The Module Definition window opens. This window enables you to define specific 
parameters for the cyclic EtherNet/IP connection as well as the number of HART devices.
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Figure 5.34 Module Definition window

3. Select the maximum number of HART devices that shall be available via EtherNet/IP from 
the drop-down list.
The WirelessHART Gateway establishes 10 cyclic data transfer connections with 4 HART 
devices per connection. Thus, the number of HART devices defines the number of 
connections. Because the WirelessHART Gateway is automatically included in the first 
connection, only 3 more HART devices can be accessed via the first connection. For 
example, if you want to access 4 HART devices, select 7 from the drop-down list to 
establish a second connection for the fourth HART device.
Note that the HART descriptors of all HART devices that shall be available via EtherNet/IP 
must follow a dedicated naming convention. See chapter 5.8.1
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Review Connected HART Devices
Select the HART Device Map tab of the Add-On Profile of the WirelessHART Gateway.

 The HART device map is displayed.

Figure 5.35 Module Properties window

If required, click Refresh to reload the HART device map.

Note!
The update of the HART device map may take up to 10 minutes. If a device is connected or 
disconnected, it may take up to 10 minutes until it appears or disappears from the list.
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HART Device Map

Display Available Variables
Double-click Controller Tags in the Controller Organizer window of the Logix controller.

Figure 5.36 Controller Organizer window

 The Monitor Tags area on the right displays a detailed overview of the variables that are 
available for your Logix program.
See chapter 5.8.5

Displayed Information Description
HART Device Displays the identifier of the HART device. 

This identifier must be identical to the last 3 
characters of the HART descriptor. See 
chapter 5.8.1

Descriptor Displays the HART descriptor of the device. 
The HART descriptor must follow a dedicated 
naming convention. See chapter 5.8.1

Long Tag Name Displays the long tag name of the device.
HART Comm Fail This bit is set, if a device is not available, for 

example, if the connection to the device 
cannot be established. Note that if the 
maximum number of HART devices specified 
in the Module Definition window is higher 
than the actual number of HART devices, the 
HART Comm Fail bit is set for the missing 
devices.

Descriptor Not Unique This bit is set if the HART descriptor of the 
device is not unique.
Use the DTM of the corresponding HART 
devices to change the HART descriptors.

Data Burst Not Configured This bit is set if the HART Command 9 
(alternatively Command 3 and Command 33) 
is not bursted by the HART device.
Use the DTM of the corresponding HART 
devices to make them burst Command 9 
(alternatively Command 3 and Command 33). 
See chapter 5.8.2

Cmd48 Burst Not Configured This bit is set if the HART Command 48 is not 
bursted by the HART device.
Use the DTM of the corresponding HART 
devices to make them burst Command 48. 
See chapter 5.8.2
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Figure 5.37 Available variables
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5.8.5 Connection Parameters for Cyclic Data Transfer

Data Block of the WirelessHART Gateway used in Cyclic Data Transfer
The data block of the WirelessHART Gateway, which is transferred at the first position of the 
first connection has the following format.

Data Block of the WirelessHART Gateway
Structures Data Types Size Invalid Value Description
Gateway_struct 84

.NetworkReliability
_percent

REAL 4 Quiet NaN *1 Percentage of packets 
generated by wireless device 
correctly received by the 
WirelessHART Gateway

.NetworkStability_r
atio

REAL 4 Quiet NaN *1 Ratio of successful packets to 
total packet transmissions on 
all wireless paths

.NetworkLatency_
ms

DINT 4 -1 *1 Average time taken for 
packets generated by a 
wireless device to reach the 
WirelessHART Gateway

.LostUpstreamPac
kets

DINT 4 -1 *1 Total number of packets lost 
by the wireless device when 
transferred

Sub-structure DeviceStatus_Stru
ct

4 (always valid)

.GeneralStatus BYTE 1

.InternalError BOOL Indicates an internal error.
As a result, the four values 
above will be set to the Invalid 
Value and all devices will set 
their HARTComm fail bits.

.DescriptorNotUni
que

BOOL Indicates that at least two 
HART devices have the same 
HART Descriptor. THis is a 
summary bit for all HART 
devices.
See chapter 5.8.6

.NoDataBurstConfi
gured

BOOL Indicates that at least one 
HART device contained in 
cyclic traffic does not burst 
any of the commands 3, 9, or 
33.
See chapter 5.8.6

.NoCmd48BurstCo
nfigured

BOOL Indicates that at least one 
device contained in cyclic 
traffic does not burst 
command 48.
See chapter 5.8.6

.PassThroughQue
ueOccupied

BOOL Indicates that the maximum 
number of active Pass-
Through requests to this 
device is reached. Every 
further request will be refused.

.PassThroughRes
ponseReady

BOOL Indicates that at least one 
Pass-Through response is 
ready to be fetched.

.UnusedStatus1 BYTE 1
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The statistical values marked with *1 are invalid only if the WirelessHART Gateway has been 
started and the statistics have not been calculated yet. The calculated values reamin valid as 
long as WirelessHART Gateway is running.

Data Block of HART Devices used in Cyclic Data Transfer
This data structure is used for all devices in the Wireless HART network, except for the 
WirelessHART Gateway. Devices can be WirelessHART devices as well as HART field 
devices that are connected to a WirelessHART Adapter. While WirelessHART devices have to 
support HART Revision 7 or newer, HART field devices may only support HART Revision 5 or 
6. For these devices, not all values become applicable and some values are replaced by other 
values. Notes in the following table describe the differing behavior.

Data Block of HART Devices

.FieldDeviceStatus BYTE 1 Original status byte returned 
from WirelessHART Gateway. 
See HART specifications for 
details.

.ExtendedDeviceS
tatus

BYTE 1 Original status byte returned 
from the WirelessHART 
Gateway. See HART 
specifications for details.

Sub-structure Tag_Struct 32 (always valid)
.Name BYTE[32] 32 HART Long Tag

(ISO/IEC 8859-1)
Sub-structure CMD48_Struct 28 (always valid)

.Cmd48Data BYTE[25] CMD48 data

.Cmd48Reserved BYTE[3] padding bytes

Structures Data Types Size Invalid Value Description

Structures Data Types Size Invalid Value Description
Device_struct 96

.PV REAL 4 Quiet NaN Primary Value
(HART CMD 3/9/33)

.SV REAL 4 Quiet NaN Secondary Value
(HART CMD 3/9/33)

.TV REAL 4 Quiet NaN Third Value
(HART CMD 3/9/33)

.QV REAL 4 Quiet NaN Fourth Value

.PVStatus BYTE 1 0 Status byte
(HART CMD 9) *1

.SVStatus BYTE 1 0 Status byte
(HART CMD 9) *1

.TVStatus BYTE 1 0 Status byte
(HART CMD 9) *1

.QVStatus BYTE 1 0 Status byte
(HART CMD 9) *1

.PVUnit BYTE 1 0 Units Code
(HART CMD 3/9/33)

.SVUnit BYTE 1 0 Units Code
(HART CMD 3/9/33)

.TVUnit BYTE 1 0 Units Code
(HART CMD 3/9/33)
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*1.PVStatus.SVStatus.TVStatus.QVStatus
Status values are only valid when the related value PV, SV, TV, or FV is valid. The default value 
of 0 indicates that either nothing is received yet (PV, SV, TV, or FV are invalid) or that the 
related value is really bad (PV, SV, TV, FV do not contain Quiet NaN as value).
For HART devices not bursting CMD 9, for example, HART 5 devices, the following simple 

.QVUnit BYTE 1 0 Units Code
(HART 3/9/33)

.PVLowerRang
eValue

REAL 4 Quiet NaN Lower Range Value of Primary Value
(HART CMD 15)

.PVUpperRang
eValue

REAL 4 Quiet NaN Upper Range Value of Primary Value
(HART CMD 15)

Sub-structure DeviceStatus_
Struct

4

.GeneralStatus BYTE 1 (always valid) 
*2

.HARTCommF
ail

BOOL HART communication failure: device 
not found/HART not enabled. *3
See chapter 5.8.6

.DescriptorNot
Unique

BOOL Indicates that at least one other HART 
device has the same HART Descriptor.
See chapter 5.8.6

.NoDataBurstC
onfigured

BOOL Indicates that none of the commands 
3/9/33 is configured to be bursted by 
the HART device.
See chapter 5.8.6

.NoCmd48Bur
stConfigured

BOOL Indicates that CMD48 is not configured 
to be bursted by the HART device.
See chapter 5.8.6

.PassThrough
QueueOccupie
d

BOOL Indicates that the maximum number of 
active Pass-Through requests to this 
device is reached. Every further 
request will be refused. *4

.PassThrough
ResponseRea
dy

BOOL Indicates that at least one Pass-
Through response is ready to be 
fetched. *4

.UnusedStatus
1

BYTE 1 fixed 0x00

.FieldDeviceSt
atus

BYTE 1 (always valid) 
*2

Original status byte returned by device. 
See HART specifications for details.

.ExtendedField
DeviceStatus

BYTE 1 0x00 Original status byte returned by device. 
See HART specifications for details. *5

Sub-structure Tag_Struct 32 (always valid) 
*2

.Name BYTE[32] 32 HART Long Tag
(ISO/IEC 8859-1) *6

Sub-structure Cmd48_Struct 28
.Cmd48Data BYTE[25] filled with 0x00 

*7
CMD48 data

.Cmd48Reserv
ed

BYTE[3] padding bytes

Structures Data Types Size Invalid Value Description
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status shall be used:
00-hex: Not Connected (as long as no values is received from device yet (PV, SV, TV, FV 
contains Quiet NaN))
C0-hex: Connected (when the related value for PV, SV, TV, FV contains valid data from the 
device
*2 Always valid as long as .HARTCommFail bit is not set. Whenever .HARTCommFail is set, 
ALL values are invalid.
*3.HARTCommFail
If this bit is 1, none of the other data in Device_struct (including Sub-structures) is valid.
*4.PassThroughQueueOccupied .PassThroughResponseReady
These bits indicate only the Pass-through status of the WirelessHART Adapter itself. The 
status is completely independant from the Pass-through status of connected HART field 
devices.
*5.ExtendedFieldDeviceStatus
Only valid for devices that support HART Revision 6 or above and which burst CMD 9 or CMD 
48.
*6HART Long Tag
Devices that support HART Revision 5 return the content of Command 12 (Read Message) in 
this field, because the Long Tag is not defined in HART Revision 5. Message data also 
consists of 32 bytes.
*7.Cmd48Data
.Cmd48Data filled with 0x00 does not indicate that the Cmd48 data is invalid. Only the 
.NoCmd48BurstConfigured bit indicates if .Cmd48Data is valid or invalid. If 
.NoCmd48BurstConfigured is set , and thus the data is invalid, then .Cmd48Data will be filled 
with 0x00.

5.8.6 Diagnostic Bits in Cyclic Data Transfer
The cyclic data contains 4 error bits for each HART device. Each of the error bits may appear 
suddenly during cyclic communication when either the communication is lost or the 
configuration of one or more devices has changed.

.HARTCommFail
This bit indicates that the device with the HART descriptor calculated from cyclic connection 
number and data offset is not present, does not answer, or is still initializing. Once the device is 
initialized, this bit is reset. As soon as the connection to the device is lost, this bit is set again.

.DescriptorNotUnique
During the basic device identification procedure the HART descriptors of all devices in 
WirelessHART network are read. If the EtherNet/IP process detects that two or more devices 
share the same HART descriptor, the .DescriptorNotUnique bit is set in the cyclic data of the 
affected devices. Additionally the .DescriptorNotUnique bit inside cyclic data of WirelessHART 
itself is set as well, to indicate that at least one HART descriptor collision was detected.

Since the devices with identical HART descriptors share the same data offset in the same 
cyclic connection, the cyclic data would be filled randomly with the data of the these devices. 
To avoid this situation, the cyclic data is only filled with the data of the device, for which the 
duplicate HART descriptor was detected first. This avoids the loss of cyclic data when a new 
HART device with an identical HART descriptor is added to network. The same procedure is 
used for direct data transfer via Pass-through requests. The Pass-through request is sent to 
the device, for which the duplicate HART Descriptor was detected first.
If the device for which a duplicate HART Descriptor was detected first goes offline or changes 
its HART descriptor, the device that has been ignored is waken up from the suspended state. 
The device data of this device will then be used for cyclic data transfer and Pass-through 
requests.
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.NoDataBurstConfigured
This bit indicates that the affected device is not configured to burst Command 3, 9, or 33. This 
is detected during the extended initialization procedure as well as after every configuration 
change. Bursting of Command 3, 9, or 33 is required to publish cyclic data on EtherNet/IP 
without the need to poll all devices.

According to the HART specifications for WirelessHART devices, the burst configuration of 
wired devices has to be set up using the bridge device (WirelessHART Adapter) that connects 
the wired devices to the WirelessHART network. Burst commands that are set up directly on 
the wired device are not recognized and may cause the .NoCmd48BurstConfigured bit to be 
set.

.NoCmd48BurstConfigured
This bit indicates that the affected device is not configured to burst Command 48. This is 
detected during the extended initialization procedure as well as after every configuration 
change. Bursting of Command 48 is required to publish cyclic data on EtherNet/IP without the 
need to poll all devices.

According to the HART specifications for WirelessHART devices, the burst configuration of 
wired devices has to be set up using the bridge device (WirelessHART Adapter) that connects 
the wired devices to the WirelessHART network. Burst commands that are set up directly on 
the wired device are not recognized and may cause the .NoCmd48BurstConfigured bit to be 
set.

Note that .NoCmd48BurstConfigured bit will remain active for devices that do not support 
Command 48, for example, HART devices of revision 5.

5.8.7 Direct Data Transfer in Logix Controller
Direct data transfer is used to send custom HART commands to WirelessHART devices or 
HART field devices and to receive the related response. Furthermore, you can access some 
status information directly.

All direct data transfer is based on Class 35D-hex. Each instance of this class represents a 
single HART device of the WirelessHART network.

The following instance services are available for direct data transfer.

Tip
Direct data transfer is especially useful if you got a large number of HART field devices. In this 
case, you can use the cyclic data transfer to monitor the data of the HART field devices and 
use the direct data transfer to access additional devices, for example, to monitor the battery 
status of the WirelessHART Adapters once a day.
Nevertheless, we recommend that you use direct data transfer only if more then 40 devices 
shall be accessed in the network or if the required data cannot be mapped on one of the 
standard HART variables (PV, SV, TV, QV). Otherwise, cyclic data transfer should be 
preferred to direct data transfer.

Class Service ID Service Name
35D-hex 01-hex Get Attribute All

0E-hex Get Attribute Single
4E-hex Init Pass-through Message
4F-hex Query Pass-through Message
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Addressing
The mapping between HART devices and its assigned class instance is done via the identifier 
in the HART descriptor of the HART device. Thus, all devices that follow the dedicated naming 
convention for HART descriptors can be accessed directly, independent of whether they are 
contained in cyclic communication or not. See chapter 5.8.1

The PLC does not need to know the unique device address of each device. Addressing a 
device using its unique HART address or Long Tag is not supported.

The Instance ID for direct data transfer is calculated using the following formula:
Instance ID = (((nth letter in alphabet) - 1) * 4) + ((number inside notation) + 1)

Relationship between Identifiers and Instance IDs

As a result, you can access the first 40 devices that can also be accessed via cyclic data 
transfer, plus another 64 devices that can only be accessed via direct data transfer.

5.8.8 Connection Parameters for Direct Data Transfer

Accessing Device Status Information
Each instance of Class 35D-hex represents a single HART device of the WirelessHART 
network and provides some status attributes containing the data of the assigned device. These 
attributes can be accessed via the standard EtherNet/IP services Get Attribute Single and 
Get Attribute All.

Sending and Retrieving Custom HART Requests in Logix Controller
Sending and receiving of HART data is handled via the Init Pass-through Message and 
Query Pass-through Message services.

Identifier in HART Descriptor Cyclic Data Transfer
Instance ID for Direct Data 
Transfer

WHA-GW 1st connection, position 1 1

@A1, @A2, @A3 1st connection, positions 2, 3, 
and 4

2, 3, 4

@B0, @B1, @B2, @B3 2nd connection, positions 1, 2, 
3, and 4

5, 6 ,7 ,8

@C0, @C1, @C2, @C3 3rd connection, positions 1, 2, 
3, and 4

9, 10, 11, 12

... ... ...
@Z0, @Z1, @Z2, @Z3 - 101, 102, 103, 104

Example!
The HART device with the identifier @B3 can be accessed directly by sending a HART 
command to Instance ID 8 of Class 35D-hex.

Attribute 
ID Access Name

Data 
Type Description

1 Get Device 
Status

BYTE[4] See table "Data Block of HART Devices" on 
page 94 > DeviceStatus_Struct.

2 Get HART 
Descripto
r

BYTE[16] See HART specifications.

3 Get HART 
Long Tag

BYTE[32] See HART specifications.
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The HART command data sent and received through the services is the raw HART data. Thus, 
the HART Data in the request packet must be encoded in Big Endian format and that the HART 
data in the reply packet is received in Big Endian format. While HART uses the Big Endian 
format, Logix uses the Little Endian format. This means the bytes in a number are in the 
opposite order so they must be reversed before use.

Logix also aligns data on boundaries that permit fast access and HART packs them into the 
smallest space. HART encodes text strings in Packed ASCII using 6 bits per letter. When 
using pass-through messaging, your Logix program must be aware of these data layout 
issues.

Pass-through Init Message Layout Details
Use the Init Pass-through Message service to send a custom HART command to a HART 
device in the WirelessHART network. The service can be initiated using ID 4E-hex.

The following tables show the request and reply packet structures.

Request Packet

The single fields are directly related to the fields of a HART command.

 The Address is provided indirectly through the Class instances. See table "Relationship 
between Identifiers and Instance IDs" on page 98

 The HART Command Number is the same as it would be passed in a real HART frame.
In case of an Extended Command Number, this fields contains only the indicator value 31 
and the real Extended Command Number is passed in the HART Data field.

 The HART Data field contains all bytes between the Byte Count field and the Check Byte 
field of a HART frame.

An immediate response to the request is sent by the WirelessHART Gateway, containing the 
status of the request and a handle for requesting the answer if the request was accepted.

If the queue for active Pass-through requests is occupied, all requests will be refused with 
Pass-through status set to Busy. Additionally the .PassThroughQueueOccupied bit in cyclic 
data is set. this bit remains active until at least one Pass-through response had arrived and was 
fetched via the Query service.

Offset Format Description Notes
0 USINT HART Command HART Command 

Number
1 USINT HART Byte Count Size of HART Data 

field
2 - 256 USINT Hart Data Hart Command Data 

(Big Endian)
Request size = 2 ... 257 bytes

Delimiter Address [Expansio
n Bytes]

Command Byte 
Count

[Data] Check 
Byte

Table 5.16 HART Frame Format
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Reply Packet

Pass-through Query Message Layout Details
Use the Query Pass-through Message service to request a response to a custom HART 
command that was sent via the Init Pass-through Message service. The service can be 
initiated using ID 4F-hex.

The following tables show the request and reply packet structures.

Request Packet

Reply Packet

Byte Format Description Notes
0 USINT Pass-through Status See table "Pass-through Status" on page 

101
1 USINT HART Command Echo
2 USINT Handle Handle for use with the Query service that 

identifies the HART message
Only valid if Pass-Through Status = Initiated

3 USINT Queue Space 
Remaining

 Pass-through Status = Initiated or Busy
Number of requests that can still be 
queued

 Pass-through Status = Dead
Pass-through Error Code
See table "Pass-through Error Codes" 
on page 101

Reply size = 4 bytes

Byte Format Description Notes
0 USINT Handle Identifies the HART message. Received by 

the Init service.
Request size = 1 byte

Byte Format Description Notes
0 USINT Pass-through Status See table "Pass-through Status" on page 101
1 USINT HART Command Echo of HART Command
2 USINT HARTCommStatus HART Response Code

(Response Status Byte #1)
3 USINT HART Field Device 

Status
 Pass-through Status = Success

HART Field Devcie Status / 
Communication Status
(Response Status Byte #2)

 Pass-through Status = Dead
Pass-through Error Code
See table "Pass-through Error Codes" on 
page 101

4 USINT HART Byte Count Number of Data Bytes in Reply for HART 
Command

5 - 259 USINT HART Data HART Response Data (Big Endian, as many 
bytes as in HART Byte Count)

Reply size = 6 ... 260 bytes
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If at least one Pass-through response is ready to be fetched, the 
.PassThroughResponseReady bit is set in cyclic data of the device, the response come from. 
Each pending response is automatically discarded 15 seconds after the response arrived at 
the WirelessHART Gateway. Depending on the RPI of the cyclic connection, the time between 
the cyclic message where the .PassThroughResponseReady bit is set and the time the 
response is discarded, may be shorter than 15 seconds.

Pass-through Status

Pass-through Error Codes

Value Name Service Description
0 Success Query Device response received. No errors.
32 Busy - Try again later Init Command not started because there is no 

more space in the queue.
33 Initiated - Command 

started
Init Command successfully started. Use Query 

service to poll for response.
34 Running - Try again 

later
Query Command response not received yet.

35 Dead Init/Query An error occurred.
See table "Pass-through Error Codes" on 
page 101

Value Definition Description
81-hex No response from HART 

device
There is a device with a HART descriptor 
matching the one calculated by the addressed 
Class Instance, but the connection to the device 
was lost.

87-hex Instance does not have a 
device connected

There is no device with a HART Descriptor 
matching the one calculated by the address 
Class Instance.

89-hex Size of message too small to 
hold size of HART message

The EtherNet/IP process looks at the size of the 
HART Data field in the request and validates 
that the incoming message size is large enough 
to send all of the data.

8A-hex Invalid handle The handle contained in the Query service 
request could not be associated to any pending 
request.
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6 Configuration via Device Type Manager (DTM) and 
PACTware
If using the device type manager (DTM) and PACTware to configure the WirelessHART 
gateway, the WirelessHART gateway must be connected via Ethernet or RS-485.

Configuration via DTM is identical to the configuration via web interface with the 
exception of a few options that are pointed out in the relevant sections. Thus, after you have 
added the communication DTM and the device(s) in PACTware, you can follow the 
instructions for configuration via web interface.

You can download PACTware, the WirelessHART DTM, the HART IP Communication DTM, 
and the HART Communication DTM from www.pepperl-fuchs.com.

Creating a New Project?

Select File > New or click Create New Project.

 A new, unnamed project appears in the main window. The project initially consists of the 
entry HOST PC.

Updating the Device Catalog
1. Start PACTware.
2. Select View > Device Catalog.

 The Device Catalog window opens.
3. Click Update Device Catalog to update the device catalog.
4. Click Yes to continue.

 The updated device catalog appears.

6.1 Ethernet Communication
In order to enable Ethernet communication, you need to add the HART IP Communication 
DTM to your project first.

Adding HART IP Communication DTM
1. Select HOST PC in the project view.

2. Choose Device > Add device or click Add device.
3. Select the entry HART IP Communication.
4. Click OK.

 The HART IP Communication DTM is added to the project.

Figure 6.1 HART IP Communication DTM in project view

5. To edit the parameters, right-click HART IP Communication and select Properties.
6. Set the parameters according to your preferences. In most cases, the default values should 

be fine.
7. Click OK to save the changes and to close the Properties window.

http://www.pepperl-fuchs.com
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The IP address, bus address and UDP port of the communication DTM must match the 
parameters of the WirelessHART gateway. In some cases, for example, if the  WirelessHART  
gateway has already been used in another project, you may have to edit these parameters. 
When using a new  WirelessHART gateway, there is no need to change these parameters, 
because the default settings of the  WirelessHART gateway already match the default settings 
of the Ethernet Communication DTM.

Edit DTM Addresses of the Ethernet Communication DTM
1. Right-click HART IP Communication.
2. Choose Additional Functions > Set DTM addresses.

 The Set DTM addresses window is displayed.

Figure 6.2 Set DTM address window

3. Change the parameters as required (see following table).
4. Click Update changed data to apply the new settings.
5. Disconnect and re-establish the connection between the DTM and the WirelessHART 

gateway to activate the new settings.

HART IP communication DTM WirelessHART gateway
Parameter Explanation Default Parameter Default
Tag Gateway name in the 

Project view of 
PACTware. Any name may 
be entered (not relevant for 
connection to the 
WirelessHART gateway)

WHA-GW – –

Bus Address Gateway polling address
Must match the settings of 
the WirelessHART 
gateway.

1 Parameterization > 
Wired Communication > 
Protocols > HART > Bus 
Address

1
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Search for Gateways
The Ethernet communication DTM scans and identifies gateways on the Ethernet segment 
and lists the IP addresses of the connected gateways in a table.

6.2 RS-485 Communication
In order to enable RS–485 communication, you need to add the HART Communication DTM to 
your project first.

Adding HART Communication DTM

1. Select HOST PC in the project view.

2. Choose Device > Add device or click Add device .
3. Select the entry HART Communication and click OK.

 The HART Communication DTM is added to the project.

Figure 6.3 HART Communication DTM in project view

4. To edit the parameters, right-click the HART communication DTM and select Properties.
5. Set the parameters according to the following table.
6. Click OK to save the changes and to close the parameter window.

UDP 
Address

Gateway IP address
Must match the settings of 
the WirelessHART 
gateway.

192.168.0
01.001

Parameterization > 
Wired Communication > 
Interfaces > Ethernet > 
IP Address

192.168.0
01.001

UDP Port Gateway port number 
(HART over UDP)
Must match the settings of 
the WirelessHART 
gateway.

5094 Parameterization > 
Wired Communication > 
Protocols > HART > Port 
Number

5094

HART IP communication DTM WirelessHART gateway
Parameter Explanation Default Parameter Default

Note!
The HART Communication DTM is not included in the WirelessHART DTM Collection. It can 
be downloaded separately from www.pepperl-fuchs.com.

Parameter Description Default
Communica
tion 
interface

Select HART multiplexer. HART 
modem

Port Select the COM port of the RS-485 to RS-232 converter or of the 
RS-485 to USB converter.

COM1

Baudrate Select the baud rate of the WirelessHART gateway. 19200
RTS 
Control

Depending on the RS-485 to RS-232 converter used, it may be 
necessary to switch the request-to-send control on or off, in order 
to switch correctly between reception and transmitting mode.

Toggle

http://www.pepperl-fuchs.com


WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Configuration via Device Type Manager (DTM) and PACTware

 2
01

9-
06

105

6.3 Devices
After you have added a communication DTM, add the devices for the WirelessHART gateway.

Adding Devices
1. In the project view, right-click on the entry of the communication DTM.
2. To add a device to the project, choose Add device.
3. Select the entry WHA-GW.
4. Click OK.

 The device for the WirelessHART gateway is added to the project.

Figure 6.4 New device below HART IP Communication DTM in project tree

Topology Scan
The DTM provides a topology scan wizard to detect and store the device structure of the 
scanned network in an FDT project. The scan is performed independently on each level for the 
communication DTM, the WirelessHART gateway, and the devices.

Topology Scan: Creating the Project Tree Online
You can create the complete project tree for communication DTMs using the topology scan. 
The following example shows how to create a project tree for the HART IP Communication 
DTM. Ensure that you have added HART IP Communication DTM to the project tree. Ensure 
that the HART IP Communication DTM remains active, and proceed as follows:

1. Right-click on the HART IP Communication DTM, and go to Topology Scan. 

Master Specify if you want the WirelessHART gateway to be the primary 
or the secondary master. If there is already a primary master, 
define the WirelessHART gateway as secondary master.

Primary 
Master

Preamble Select the number of preambles for HART communication. 5
Number of 
communica
tion retries

Select the number of retries for HART communication in case of 
an error.

3

Start 
address

Select the address range in which the HART Communication 
DTM searches for HART multiplexers.

0

End 
address

15

Parameter Description Default

Tip
After you have added the device for the WirelessHART gateway, you can easily add other 
WirelessHART devices by performing a topology scan. To do so, right-click the WirelessHART 
gateway and select Connect. When you have an active connection to the WirelessHART 
gateway, right-click the WirelessHART gateway and select Topology Scan.

Note!
Note on Hardware Version
Automatic topology scanning is possible with the WirelessHART gateway, revision 3 or higher. 
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 The topology scan wizard opens.
2. Optionally, you can make settings for the HART IP communication DTM: In the Scan Tree, 

right-click onto the HART IP Communication DTM. From the context menu that opens, 
select DTM Functions > Parameter. In the Settings section on the right, for the HART IP 
Communication DTM enter a suitable project tag, determine the communication timeout, 
and the number of retries. 

Figure 6.5 Parameter > DTM Functions for HART IP Communication DTM 
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3. In order to start the topology scan, click on the blue single arrow (1) in the lower left section 
of the wizard dialog.

 Scanning is indicated by a status bar. All gateways on the network are listed. All devices 
that are connected to the gateways are listed. As scanning takes place, the Scan Tree 
section fills with all the detected participants of network, at the same time the project tree is 
updated.

Figure 6.6 Topology scan: Filling up project tree while scanning 

4. Close the topology scan wizard.
 Your FDT project tree is complete.

1
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Rescanning in Case of Failed Device Detection
In case the topology scan cannot detect any connected devices, ensure that all devices are 
switched on. Then you can manually rescan the topology as follows:

1. Manually rescan the WirelessHART adapter. Assign a device type and a semantic ID man-
ually. Confirm by clicking on Apply. 

Figure 6.7 Topology scan wizard: Issues after completing the scan, in general unkown devices 
on the network

2. Close the topology scan wizard.
 Your FDT project tree is complete.

6.4 Online and Offline Parameterization (PACTware)
The concept of online and offline parameterization applies only to configuration via device type 
manager (DTM) with PACTware.

 Offline Parameterization (not connected to device)
If there is no active connection to the device, you can edit and save the data that is stored 
locally in PACTware. You can transfer the local data to the device, as soon as a 
connection to the device has been established.

 Online Parameterization (connected to device)
If there is an active connection to the device, you can directly edit the data that is stored 
on the device. Parameter changes are immediately stored on the device.

Offline Parameterization
1. Right-click the device in the PACTware project view.
2. Choose Parameter > Offline Parameterization.

 The window containing the offline data record appears.

Note!
Data that is edited and stored on the device during online parameterization is not automatically 
synchronized with the offline data in the PACTware project. If you change device parameters in 
online mode, the data in PACTware differs from the data on the device. To make sure the data 
in PACTware matches the data on the device after online parameterization, load the data from 
the device into the PACTware project.
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3. Modify a parameter by typing in a new value or choosing a new value from the drop-down 
list.

4. To accept the new value, press Enter.
5. After all parameter changes have been made, save your project by choosing File > Save.
6. To write the new offline configuration to the device, right-click the device in the project view 

and choose Connect.
 A connection to the device is established.

7. Right-click the device again and choose Store to device.
 The new configuration is stored in the device.

Online Parameterization

1. Right-click the device in the PACTware project view.
2. Select Connect.

 A connection to the device is established.
3. Right-click the device in the PACTware project view.
4. Select Parameter > Online Parameterization.

 The window containing the online data opens and the data is read from the device.
5. Modify a parameter by typing in a new value or choosing a new value from the drop-down 

list.
6. To accept the new value, press Enter.

 The new value is stored in the device immediately.
7. After all parameter changes have been made, you can load the online configuration into the 

PACTware project. To do this, right-click on the device entry in the project view and choose 
Load from device.

8. Save your project by choosing File > Save.

Note!
Some options are only available during online parameterization. These options are pointed out 
in the relevant sections.
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7 Configuration via DD file and Emerson AMS Suite
You can also configure the WirelessHART gateway by integrating it into a process control 
system. The exact procedure how to integrate a device depends on the process control 
system. Please refer to the documentation of your process control system manufacturer.

You can download the device description for the WirelessHART gateway from www.pepperl-
fuchs.com. Install the DD file according to the instructions from the documentation of your 
process control system manufacturer.

This manual describes the integration into a process control system using the example of the 
Emerson AMS Suite. When integrating the WirelessHART gateway into the Emerson AMS 
Suite, the WirelessHART gateway must be connected to your PC via Ethernet.

7.1 Integration
The WirelessHART gateway is integrated into the Emerson AMS Suite by creating a new 
wireless network that is established by the WirelessHART gateway.

Create New Wireless Network
1. Make sure the AMS Device Manager is not running.
2. Choose Start > Programs > AMS Device Manager > Network Configuration to start 

Network Configuration.
 The Network Configuration window appears.

Figure 7.1 Network Configuration window

3. Click Add.
4. Select Wireless Network and click Install.

 The Add Wireless Network Wizard window appears.

http://www.pepperl-fuchs.com
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Figure 7.2 Add Wireless Network Wizard window

5. Click Next.
6. Enter a name for the network in the Network Name field and click Next.
7. Enter the IP address of the WirelessHART gateway in the Smart Wireless Gateway 

Name or IP Address field and click Add. The default IP address is 192.168.001.001. If 
you changed the IP address of the WirelessHART gateway, type in the new IP address.



 2
01

9-
06

112

WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Configuration via DD file and Emerson AMS Suite

Figure 7.3 Connection window

 The IP address is displayed in the upper area under Wireless Network Parameters.
8. Click Finish to close the Add Wireless Network Wizard.

 The name of the new wireless network is displayed in the Network Configuration 
window.

9. Click Close to exit Network Configuration.
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7.2 Configuration
The Device Connection View is a graphical representation of the WirelessHART gateway 
and the connected wireless and wired subdevices. From this view you can directly open the 
configuration window for each device.

Display Network Participants
1. Start the AMS Device Manager as administrator. To do so, right-click the program icon and 

select Run as administrator.

Figure 7.4 Run as administrator

2. Log in to the AMS Device Manager using your user name, password, and the Standard 
login type.

3. To establish a connection to your devices, choose View > Device Connection View.
 The Device Connection View window displays the networks from the Network 

Configuration window. In this example, Wireless Network 1 represents the 
WirelessHART network that is established by the WirelessHART gateway.
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Figure 7.5 Device Connection View window

4. Right-click the network that is created by the WirelessHART gateway and select Rebuild 
and Identify Hierarchy.

 The WirelessHART gateway is displayed underneath the network. Note that if the device 
description has been installed, the WirelessHART gateway is displayed with a device-
specific icon. Otherwise the system uses a generic icon.

Figure 7.6 WirelessHART gateway in Device Connection View

5. To view the wireless and wired subdevices of the WirelessHART gateway, click the + 
symbol in front of the device icon.

 The AMS Device Manager checks the HART loops and adds the field devices to the 
network tree. Depending on the number of network participants and the network topology, 
this process can take up to a few minutes.

Configure WirelessHART Gateway

1. To open the configuration window, double-click the WirelessHART gateway in the Device 
Connection View.

 The configuration window of the selected device appears.

Note!
Unless the device description has been installed, you can only configure basic options. The 
device description adds device-specific options to the configuration window.
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Figure 7.7 Configuration window

2. If you change the value of a field, the background color of this field turns yellow. To apply 
the changes, click Send.

Figure 7.8 Changes are highlighted in yellow

 The system displays a warning message, asking you to provide an update reason and to 
confirm that you want to change the values.
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Figure 7.9 Confirm Device Configuration Change window

3. To confirm the configuration change, click Yes.
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8 Operation
8.1 Network Enhancement

After having installed and set up a wireless network, give the network a couple of hours to 
stabilize itself before taking the following steps.

Once the WirelessHART network is running, there are some simple measures that will help 
enhancing network performance and reliability. Those measures are described in the 
following.

Verify Connections
Check that each device has joined the network and is communicating properly. See chapter 
5.4.2 Details

If you cannot establish a connection to a device, the device is probably too far away or an 
obstacle blocks the radio waves. In this case, add an additional device to bridge the gap.

Eliminate Bottlenecks
If the messages of several devices all have to pass through one single device to get to the 
WirelessHART gateway, the network has a bottleneck. If the device at the bottleneck fails, 
whole parts of the network get cut off from communication because there are no alternative 
paths to route messages.

To eliminate bottlenecks in a wireless network, add at least one device near the bottleneck to 
provide redundant communication paths.
There should always be at least two communication paths from one device to another.

Figure 8.1 Eliminating a bottleneck

1. Bottleneck
2. WirelessHART gateway
3. Possible position of an additional WirelessHART device eliminating the bottleneck
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Expand the Network
In an industrial environment, there are several potential obstacles for radio waves, for example 
buildings, walls, pipes, or even moving obstacles like trucks. Those obstacles can reflect, 
bend, diffuse or block radio waves. The effects of reflection, bending and diffusion create new 
waves which interact with the original ones and with each other. They can amplify or nullify 
each other.

Due to the interference of reflections, moving the antenna a few centimeters can help. If there 
are obstacles blocking data transfers between wireless devices, add additional devices to 
provide alternative communication paths. The more devices exist in a WirelessHART network, 
the more reliable it gets.

Optimize Coexistence with other Wireless Networks
WirelessHART networks use the frequency spectrum between 2400 ... 2483.5 MHz according 
to IEEE 802.15.4. Various other wireless technologies also use this frequency spectrum, for 
example WLAN (IEEE 802.11) and Bluetooth (IEEE 802.15.1). Measures must be taken to 
ensure that the various wireless technologies do not affect each other.

If there are problems with other wireless technologies disrupting the WirelessHART network, 
create a channel blacklist that makes the WirelessHART gateway skip certain channels known 
to provide persistent interference. 
If possible, you can also manage the frequencies used by other networks and block the usage 
of channels already used by the WirelessHART network (frequency management).
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9 Maintenance and Repair
9.1 WHA-GW*

The national requirements apply to maintenance, servicing, and inspection of associated 
apparatus.

No maintenance is necessary if the devices are operated properly, observing the mounting 
instructions and ambient conditions.

The device must not be repaired, changed, or manipulated. In case of failure, always replace 
the device with an original device.

Danger!
Danger to life from using damaged or repaired devices.

Using a defective or repaired device can compromise its function and its electrical safety.

 Do not use a damaged or polluted device.
 The device must not be repaired, changed or manipulated.
 If there is a defect, always replace the device with an original device from Pepperl+Fuchs.

Danger!
Explosion hazard or loss of radio approval through unsuitable accessories

The use of unsuitable or unapproved accessories may void the Ex certification or radio 
approval of the device and present an explosion hazard or violate the national radio 
regulations.

Only use suitable, certified remote antennas and accessories that are listed in the installation 
examples or that respect the limits mentioned below. If in doubt, consult your national 
regulations expert.

Danger!
Danger to life from electric shock through degree of protection violation

Failing to ensure the degree of protection for the enclosure according to EN 60529 can result in 
severe or lethal electric shock.

Ensure that the enclosure meets the required degree of protection during mounting and 
installation activities: 
- All seals must be undamaged and correctly fitted
- All screws of the housing/housing cover must be tightened with the appropriate torque
- Only cables of the appropriate size must be used in the cable glands
- All cable glands must be tightened with the appropriate torque
- All unused cable glands must be sealed or plugged with corresponding stopping plugs

Danger!
Explosion hazard from premature powering

Powering parts of the system during installation or maintenance leads to added currents. This 
very likely results in a current flashover generating sparks. The sparks can ignite the 
surrounding potentially explosive atmosphere. 

Prior to installation and maintenance activities, ensure that the device is disconnected from the 
power supply. Activate the power supply only after all the circuits required for operation have 
been fully assembled and connected 
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10 Troubleshooting
10.1 Faults Indicated by LEDs of the WirelessHART Gateway

10.2 Wired Communication Faults

Indication Possible cause Corrective action
Red LED is on Hardware fault that makes normal 

operation of the WirelessHART 
gateway impossible.

Try powering the WirelessHART 
gateway down and up again. If the 
problem persists, please return the 
WirelessHART gateway to 
Pepperl+Fuchs for repair.

Red LED flashes Under certain conditions the LED 
flashes while the WirelessHART 
gateway tries to eliminate the fault.

If the problem persists, please 
contact Pepperl+Fuchs customer 
service.

Fault Possible cause Corrective action
The host is not 
able to establish 
an Ethernet 
connection to the 
WirelessHART 
gateway.

The WirelessHART 
gateway is connected to 
the Ethernet with a straight 
through connection 
although a crossover 
connection is necessary 
(or vice versa).

Access the Ethernet interface of the 
WirelessHART gateway. 
Interchange the green wire with the orange 
one, and the white/orange wire with the 
white/green one. 
This action changes a crossover connection 
into a straight-through connection and vice 
versa.

The Ethernet parameters 
of the WirelessHART 
gateway are incorrect.

Check the Ethernet parameters of the 
WirelessHART gateway. See chapter 5.3.2

The Local Area 
Connection Properties of 
your PC are not configured 
correctly.

Configure the Local Area Connection 
according to the instructions given. 

If you are parameterizing 
via the web interface: 
Maybe your web browser 
uses proxies.

Deactivate proxies in your browser.

The host is not 
able to establish 
a serial 
connection to the 
WirelessHART 
gateway.

Wrong parameters (e.g. 
COM port, address range) 
are set in the 
communication DTM.

Check the parameters in the communication 
DTM. See chapter 6.2
Also check the baud rate/polling address 
configured via the DIP switches inside the 
enclosure. 

The host is not 
able to establish 
a serial 
connection to the 
WirelessHART 
gateway, or the 
signal quality is 
poor.

The terminator is not 
activated.

If the RS-485 bus ends at the WirelessHART 
gateway, activate the terminator by setting 
DIP switch number 7 to ON () or by using the 
serial interface ().
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10.3 Wireless Communication Faults
Fault Possible cause Corrective action
The 
WirelessHART 
gateway cannot 
find a 
WirelessHART 
device in the 
network.

The device has not yet 
joined the network.

The joining process may take a while. Check 
the join status in the instrument list of the 
WirelessHART gateway. Alternatively, check 
the wireless communication parameters (join 
status) of the device via a HART modem 
connected to the device.

The device carries the 
wrong network ID and/or 
the wrong join key.

Check the wireless communication 
parameters of the device via a HART modem 
connected to the device. The device and the 
WirelessHART gateway must have the same 
network ID and join key.

There are not enough 
neighboring 
WirelessHART devices 
within the device's antenna 
range.

Check the number of neighbors (Diagnosis > 
Wireless Communication). There should be at 
least 2 neighbors.

The wireless 
connection to a 
WirelessHART 
device is poor 
and disappears 
from time to time

There are not enough 
neighboring 
WirelessHART devices 
within the device's antenna 
range.

Check the number of neighbors (Diagnosis > 
Wireless Communication). There should be at 
least 2 neighbors.

Walls or other 
static/moving objects block 
the radio signals, or the 
antenna is not aligned 
vertically.

Check the position of the WirelessHART 
gateway or use an external antenna. See 
chapter 3.1
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11 Telecommunication Compliance
 ETSI (R&TTE)
 FCC Part 15.247 for wireless applications in the area of 2.4 GHz
 EN 300 328

The usage of 2400 MHz equipment is bound to local restrictions. Ensure that local restrictions 
allow usage of this device before commissioning.

Country Guideline
Bulgaria General authorization required for outdoor use and public service.
Italy If used outside of own premises, general authorization is required.
Japan The device is granted pursuant to the Japanese Radio Law and the 

Japanese Telecommunications Business Law.
The device must not be modified (otherwise the granted designation 
number will become invalid).

Latvia The outdoor usage of the 2.4 GHz band requires an authorization 
from the Electronic Communications Office.

Norway May be restricted in the geographical area within a radius of 20 km 
from the center of Ny-Alesund.

Rumania Use on a secondary basis. Individual license required.
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12 Appendix
12.1 HART Status Information

HART Device Status
The HART device status or field device status indicates the current operating status of the field 
device.

HART Extended Device Status

Code Parameter Description
0x01 Primary Variable 

Out Of Limits
The PV is beyond its operating limits.

0x02 Non-Primary 
Variable Out Of 
Limits

A device variable not mapped on the PV is beyond its operating 
limits.

0x04 Loop Current 
Saturated

The loop current has reached its upper (or lower) endpoint limit 
and cannot increase (or decrease) any further.

0x08 Loop Current 
Fixed

The loop current is being held at a fixed value and is not 
responding to process variations.

0x10 More Status 
Available

More status information is available via command 48.

0x20 Cold Start A power failure or device reset has occurred.
0x40 Configuration 

Changed
An operation was performed that changed the configuration of 
the device.

0x80 Device 
Malfunction

The device detected a serious error or failure that compromises 
device operation.

Code Parameter Description
0x01 Maintenance 

Required
This bit is set to indicate that, while the device has not 
malfunctioned, the field device requires maintenance.

0x02 Device Variable 
Alert

This bit is set if any device variable is in an alarm or warning 
state. The host should identify the device variable(s) causing this 
to be set using the device variable status indicators.

0x04 Critical Power 
Failure

For battery powered devices. This bit is set when the power is 
becoming critically low. Devices must be able to sustain their 
network connection for at least 15 minutes from when this bit is 
set.

0x08 Failure When this bit is set, one or more device variables (for example, 
measurement or control values) are invalid due to a malfunction 
of the field device or its peripherals.

0x10 Out Of 
Specification

When set, this bit indicates deviations from the permissible 
ambient or process conditions have been detected that may 
compromise measurement or control accuracy (for example, 
device performance may be degraded given current operating 
conditions).

0x20 Function Check This bit is set if one or more device variables are temporarily 
invalid (for example, frozen) due to ongoing work on the device.
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Command 48
Command 48 returns additional status information that is not included in the HART device 
status response code.

All field devices must support at least bytes 0 ... 8. Thus, the minimum response length of 
command 48 is 9 bytes. If a field device supports more than one analog channel, bytes 9 ... 13 
must be supported as well. In this case, the minimum response length of command 48 is 14 
bytes.

Response Data Bytes
Byte Parameter Description
0 Device-Specific 

Status 0
Extended Device 
Malfunction

 0x01 Manager Fault
 0x02 Non-Volatile Memory Defect
 0x04 Volatile Memory Defect
 0x08 Ethernet Communication Fault
 0x10 Wired Device Duplicated
 0x20 Long Tag Duplicated
 0x40 Electronic Defect
 0x80 RS-485 Communication Fault

1 Device-Specific 
Status 1
Gateway 
Operation in 
Progress

 0x02 Block Transfer (not supported)
 0x04 Delayed Answer
 0x08 Self-Test (not supported)
 0x20 Device List Update
 0x40 Network Manager Reset In Progress
 0x80 Start-Up Phase

2 Device-Specific 
Status 2
Extended Lists 
Changes

 0x01 Instrument List Changed
 0x04 Active Device List Changed

3 Device-Specific 
Status 3
Cumulative 
Device Status

 0x01 Primary Variable Out Of Limits
 0x02 Non-Primary Variable Out Of Limits
 0x04 Loop Current Saturated
 0x08 Loop Current Fixed
 0x10 More Status Available
 0x20 Cold Start
 0x40 Configuration Changed
 0x80 Device Malfunction

4 Device-Specific 
Status 4
Device Operation 
in Progress

 0x01 Maintenance Required
 0x02 Device Variable Alert
 0x04 Critical Power Failure

5 Device-Specific 
Status 5
Device Operation 
in Progress

 0x02 "Configuration Changed Bit Reset" Procedure
 0x04 "Sub-Device Update" Procedure
 0x08 "Device Update" Procedure

6 Extended Device 
Status

Not available
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7 Device Operating 
Mode

Not available

8 Standardized 
Status 0
Standardized 
Device 
Malfunction

 0x01 Simulation Active
The device is in simulation mode and one or more of its 
device variables are not representative of the process.

 0x02 Non-Volatile Memory Defect
The non-volatile memory check is invalid or corrupt, or the 
battery of a battery-powered memory is defective.

 0x04 Volatile Memory Defect
The RAM memory check is invalid or corrupt.

 0x08 Watchdog Reset Executed
A watchdog reset has been executed.

 0x10 Environmental Conditions Out Of Range
An internal or environmental condition is beyond acceptable 
limits.

 0x20 Power Supply Conditions Out Of Range
The power supply is outside its allowable range.

 0x40 Electronic Defect
A hardware problem has been detected.

9 Standardized 
Status 1

Not available

10 Analog Channel 
Saturated

Not available

11 Standardized 
Status 2
Standardized 
Lists Changes

 0x01 Instrument List Changed
When set, the gateway has lost communication with one of its 
sub-devices or discovered a new sub-device. This bit is reset 
if command 74 is issued. The current sub-device list is read 
using command 84.

 0x02 Duplicate Master Detected
The adapter has discovered another master with the same 
address connected to its token-passing interface.

12 Standardized 
Status 3

Not available

13 Analog Channel 
Fixed

Not available

14 ... 24 Device-Specific 
Status 
Information

Not available

Byte Parameter Description
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12.2 Structure of CSV Files
Use a semicolon ; as separator for the values in the CSV file. If a value already contains a 
semicolon you must put the value into quote signs ". If the value already contains quote signs, 
put the entire value into quote signs " and replace the original quote signs with two quote signs 
"".

Avoid special characters. They can easily be corrupted or they can cause the whole data row 
to be skipped during the import of the CSV file.

Avoid leading blanks, trailing blanks, and tabs, especially for integer or hexadecimal values.

Respect the data type of each column.

If a mandatory column is missing, the whole file is rejected and nothing is imported.

If a mandatory value is missing, the corresponding data row is skipped.

Instrument List
The files for the instrument list contain the following columns.

File Structure

Topology View
The files for the topology view contain the following columns.

Note that the X- and Y-origins of the background image are not part of the CSV file, as these 
coordinates are related to the background image.

File Structure

Diagnostic Details
The files you can export under Diagnostics > Wireless Communication > Details contain 
the following columns. There are no mandatory columns as there is no import function. 
Nevertheless, you can export the data in CSV format for documentation.

Example!
The value this is a "long tag" that contains quote signs must be entered like this:
"this is a ""long tag"" that contains quote signs"

Expanded Device 
Type Code Device Id IO-Card Channel Long Tag
4 digits hex 6 digits hex int decimal int decimal string[32]

mandatory

Expand
ed 
Device 
Type 
Code

Device 
Id IO-Card

Channe
l

Long 
Tag

Units 
Code Range

X-
Coordin
ate

Y-
Coordin
ate

Z-
Coordin
ate

4 digits 
hex

6 digits 
hex

int 
decimal

int 
decimal

string[3
2]

int 
decimal

float 
decimal

float 
decimal

float 
decimal

float 
decimal

mandat
ory

mandat
ory

mandat
ory
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File Structure

12.3 Supported Commands
The following tables show the HART commands supported by the device.

12.3.1 Universal Commands

Expa
nded 
Devic
e 
Type 
Code

Devic
e Id

IO-
Card

Chan
nel

Long 
Tag

Statu
s

Devic
e 
Statu
s

Num
ber 
Of 
Joins

Rece
nt 
Join 
Date

Relia
bility

Laten
cy

Neig
hbors RSSI

Stabi
lity

4 
digits 
hex

6 
digits 
hex

int 
deci
mal

int 
deci
mal

string
[32]

2 
digits 
hex

2 
digits 
hex

int 
deci
mal

yyyy:
mm:d
d 
hh:m
m:ss

float float string
[32]

int 
deci
mal

float

Note!
Unlike a HART multiplexer the WirelessHART gateway only accepts commands directly 
addressed to its HART slave address.

Command Action Description
Identity Commands
0 Read unique identifier 12 Bytes device identifier are given in 

the response
11 Read unique identifier using tag 12 Bytes device identifier are given in 

the response, if the given tag complies 
to the tag of the gateway

21 Read unique identifier using long tag 12 Bytes device identifier are given in 
the response, if the given long tag 
complies to the long tag of the 
gateway

Static Parameter Commands
13 Read tag, descriptor, date Read the 8 digit tag, the 16 digit 

description and the date.
18 Write tag, descriptor, date Write the 8 digit tag, the 16 digit 

description and the date
12 Read message Read the 32 digit message
17 Write message Write the 32 digit message
20 Read long tag Read the 32 digit long tag
22 Write long tag Write the 32 digit long tag
16 Read final assembly number
19 Write final assembly number
Status Commands
38 Reset configuration changed flag Reset the "Configuration changed" 

response code
48 Read additional status
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12.3.2 Common Practice Commands
Command Action Description
Device Management Commands
41 Perform device self test Initiates the self test function in the 

device
42 Perform device reset Immediately after the response the 

microprocessor of the device will be 
reset.

89 Set real-time clock 12 Bytes device identifier are given in 
the response, if the given long tag 
complies to the long tag of the 
gateway.

90 Read real-time clock
512 Read country code
513 Write country code
Data Link Layer Commands
59 Write number of response preambles The number of preambles insert in 

response telegrams can vary from 2 to 
20. Default setting is 4.

106 Flush delayed response buffers Flush all gateway DR buffers.
I/O System Commands
74 Read I/O system capabilities Also returns number of detected 

devices.
77 Send command to sub-device using 

card/channel
Request embeds full Hart command.

85 Read I/O channel statistics using 
card/channel

Read channel communication 
statistics.

86 Read sub-device statistics using list 
index

Read device communication 
statistics.

84 Read sub-device identity summary 
using list index

Allows to read the Instrument list (a 
single item at a time).

I/O System (HOST I/F) Commands
88 Write I/O system retry count
94 Read I/O system host statistics Read host I/F communication 

statistics.
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12.3.3 Wireless Commands

12.3.4 Device Commands

Command Action Description
Network information commands
768 Write join key Write the network's unique join key. 

Only possible in  ().
773 Write network ID Write the unique network ID.
774 Read network ID Read the unique network ID.
775 Write network tag Write the network tag. The network 

tag identifies the device in the 
WirelessHART network.

776 Read network tag Read the network tag.
794 Read UTC time mapping Read the time setting for the network.
797 Write Radio Power
798 Read Radio Power
840 Read Network Device's Statistics
Active / White / Black lists commands
814 Read Device List entries using list 

index
816 Delete device List table entry using 

unique ID
821 Write network access mode
822 Read network access mode

Command Action Description
835 Read network device burst mode list 

using unique ID
Read the device burst message list.

836 Flush device cached responses using 
unique ID

Instructs the gateway to flush all 
cached responses for the relevant 
device.
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12.4 Software License

Open Source Software Information
The product you have bought uses open source software. According to the open source 
license terms and conditions for the use of the open source software we provide you with the 
following information:

1. Under the program source code you will find a list of the different open source software em-
bedded in the product. The program source code is available under www.pepperl-
fuchs.com.

2. In the list the copyright owners of the respective open source software are named.
3. Under the program source code the license terms and conditions for the use of the differ-

ent open source software are available.
4. The sublicense for the use of the open source software embedded in the product is grant-

ed to you under the same license terms and conditions as required by the copyright own-
ers (see Nr. 3 above).

5. We expressly point out that the license terms and conditions contain extensive limitations 
of liability.

12.5 Supported Commands
The following tables show the HART commands supported by the device.

12.5.1 Universal Commands

Note!
Unlike a HART multiplexer the WirelessHART gateway only accepts commands directly 
addressed to its HART slave address.

Command Action Description
Identity Commands
0 Read unique identifier 12 Bytes device identifier are given in 

the response
11 Read unique identifier using tag 12 Bytes device identifier are given in 

the response, if the given tag complies 
to the tag of the gateway

21 Read unique identifier using long tag 12 Bytes device identifier are given in 
the response, if the given long tag 
complies to the long tag of the 
gateway

Static Parameter Commands
13 Read tag, descriptor, date Read the 8 digit tag, the 16 digit 

description and the date.
18 Write tag, descriptor, date Write the 8 digit tag, the 16 digit 

description and the date
12 Read message Read the 32 digit message
17 Write message Write the 32 digit message
20 Read long tag Read the 32 digit long tag
22 Write long tag Write the 32 digit long tag
16 Read final assembly number
19 Write final assembly number
Status Commands

http://www.pepperl-fuchs.com
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12.5.2 Common Practice Commands

38 Reset configuration changed flag Reset the "Configuration changed" 
response code

48 Read additional status

Command Action Description

Command Action Description
Device Management Commands
41 Perform device self test Initiates the self test function in the 

device
42 Perform device reset Immediately after the response the 

microprocessor of the device will be 
reset.

89 Set real-time clock 12 Bytes device identifier are given in 
the response, if the given long tag 
complies to the long tag of the 
gateway.

90 Read real-time clock
512 Read country code
513 Write country code
Data Link Layer Commands
59 Write number of response preambles The number of preambles insert in 

response telegrams can vary from 2 to 
20. Default setting is 4.

106 Flush delayed response buffers Flush all gateway DR buffers.
I/O System Commands
74 Read I/O system capabilities Also returns number of detected 

devices.
77 Send command to sub-device using 

card/channel
Request embeds full Hart command.

85 Read I/O channel statistics using 
card/channel

Read channel communication 
statistics.

86 Read sub-device statistics using list 
index

Read device communication 
statistics.

84 Read sub-device identity summary 
using list index

Allows to read the Instrument list (a 
single item at a time).

I/O System (HOST I/F) Commands
88 Write I/O system retry count
94 Read I/O system host statistics Read host I/F communication 

statistics.



 2
01

9-
06

132

WHA-GW-F2D2-0-A*-Z2-ETH.EIP
Appendix

12.5.3 Wireless Commands

12.5.4 Device Commands

12.6 Software License

Open Source Software Information
The product you have bought uses open source software. According to the open source 
license terms and conditions for the use of the open source software we provide you with the 
following information:

1. Under the program source code you will find a list of the different open source software em-
bedded in the product. The program source code is available under www.pepperl-
fuchs.com.

2. In the list the copyright owners of the respective open source software are named.
3. Under the program source code the license terms and conditions for the use of the differ-

ent open source software are available.
4. The sublicense for the use of the open source software embedded in the product is grant-

ed to you under the same license terms and conditions as required by the copyright own-
ers (see Nr. 3 above).

5. We expressly point out that the license terms and conditions contain extensive limitations 
of liability.

Command Action Description
Network information commands
768 Write join key Write the network's unique join key. 

Only possible in  ().
773 Write network ID Write the unique network ID.
774 Read network ID Read the unique network ID.
775 Write network tag Write the network tag. The network 

tag identifies the device in the 
WirelessHART network.

776 Read network tag Read the network tag.
794 Read UTC time mapping Read the time setting for the network.
797 Write Radio Power
798 Read Radio Power
840 Read Network Device's Statistics
Active / White / Black lists commands
814 Read Device List entries using list 

index
816 Delete device List table entry using 

unique ID
821 Write network access mode
822 Read network access mode

Command Action Description
835 Read network device burst mode list 

using unique ID
Read the device burst message list.

836 Flush device cached responses using 
unique ID

Instructs the gateway to flush all 
cached responses for the relevant 
device.

http://www.pepperl-fuchs.com
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